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C H A P T E R 1
Integration Description

• Integration Description, on page 1

Integration Description

Introduction
Cisco Unity Connection supports integrations through TIMG units (media gateways) with supported phone
systems that provide in-band call information and MWI requests through the T1 digital lines.

Unity Connection supports integrations through TIMG units (media gateways) with the following phone
systems:

• Any phone system that provides call information and MWI requests through a serial data link (SMDI,
MCI, or MD-110 protocol) to the master TIMG unit. For details, see the "Serial Integration with TIMG
Units" section.

• A supported phone system that provides in-band call information and MWI requests—through the T1
digital lines. For details, see the "In-Band Integration with TIMG Units" section.

Serial Integration with TIMG Units
The phone system sends call information and MWI requests through the data link, which is an RS-232 serial
cable that connects the phone system and the master TIMG unit. Voice connections are sent through the T1
digital lines between the phone system and the TIMG units. The TIMG units communicate with the Unity\\
Connection server through the LAN or WAN using Session Initialization Protocol (SIP). Figure 1-1 shows
the required connections for a serial integration using TIMG units.
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Figure 1: Connections for a Serial Integration Using TIMG Units

In-Band Integration with TIMG Units
The phone system sends call information, MWI requests, and voice connections through the T1 digital lines,
which connect the phone system and the TIMG units. The TIMG units communicate with the Unity Connection
server through the LAN or WAN using Session Initialization Protocol (SIP). Figure 2: Connections for an
In-Band Integration Using TIMGUnits shows the required connections for an in-band integration using TIMG
units.

Figure 2: Connections for an In-Band Integration Using TIMG Units

Call Information

The phone system sends the following information with forwarded calls:

• The extension of the called party
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• The extension of the calling party (for internal calls) or the phone number of the calling party (if it is an
external call and the system uses caller ID)

• The reason for the forward (the extension is busy, does not answer, or is set to forward all calls)

Unity\\ Connection uses this information to answer the call appropriately. For example, a call forwarded to
Unity\\ Connection is answered with the personal greeting of the user. If the phone system routes the call
without this information, Unity\\ Connection answers with the opening greeting.

Serial integrations send requests to turn on and turn off MWIs through the data link.Note

Integration Functionality

The TIMG integration provides the following integration features:

• Call forward to personal greeting

• Call forward to busy greeting

• Caller ID

• Easy message access (a user can retrieve messages without entering an ID because Unity\\ Connection
identifies the user based on the extension from which the call originated; a password may be required)

• Identified user messaging (Unity\\ Connection identifies the user who leaves a message during a forwarded
internal call, based on the extension from which the call originated)

• Message waiting indication (MWI)

Integrations with Multiple Phone Systems

Unity\\ Connection can be integrated with two or more phone systems at one time. For information on the
maximum supported combinations and instructions for integrating Unity\\ Connection with multiple phone
systems, see theMultiple Phone System Integration Guide for Cisco Unity Connection Release 11.x, available
at

http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/11x/integration/guide/multiple_integration/b_cuc11xintmultiple.html.

Call Information
The phone system sends the following information with forwarded calls:

• The extension of the called party
• The extension of the calling party (for internal calls) or the phone number of the calling party (if it is an
external call and the system uses caller ID)

• The reason for the forward (the extension is busy, does not answer, or is set to forward all calls)

Unity Connection uses this information to answer the call appropriately. For example, a call forwarded to
Unity Connection is answered with the personal greeting of the user. If the phone system routes the call without
this information, Unity Connection answers with the opening greeting.

Serial integrations send requests to turn on and turn off MWIs through the data link.Note
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Integration Functionality
The TIMG integration provides the following integration features:

• Call forward to personal greeting
• Call forward to busy greeting
• Caller ID
• Easy message access (a user can retrieve messages without entering an ID because Unity Connection
identifies the user based on the extension from which the call originated; a password may be required)

• Identified user messaging (Unity Connection identifies the user who leaves a message during a forwarded
internal call, based on the extension from which the call originated)

• Message waiting indication (MWI)

Integrations with Multiple Phone Systems
Unity Connection can be integrated with two or more phone systems at one time. For information on the
maximum supported combinations and instructions for integrating Unity Connection with multiple phone
systems, see theMultiple Phone System Integration Guide for Cisco Unity Connection Release 11.x, available
at
http://www.cisco.com/c/en/us/support/unified-communications/unity-connection/products-installation-and-configuration-guides-list.html.
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C H A P T E R 2
Planning the Usage of Voice Messaging Ports in
Cisco Unity Connection

• Planning the Usage of Voice Messaging Ports in Cisco Unity Connection, on page 5

Planning the Usage of Voice Messaging Ports in Cisco Unity
Connection

Planning the Port Setup
Before programming the phone system, you need to plan how the voice messaging ports used by Cisco Unity
Connection. The following considerations affect the programming for the phone system (for example, setting
up the hunt group or call forwarding for the voice messaging ports):

• The number of voice messaging ports installed.

For a Unity Connection cluster, each server must have enough ports to handle all voice messaging traffic in
case the other server stops functioning.

• The number of voice messaging ports that answer calls.

• The number of voice messaging ports that only dial out, for example, to send message notification, to
set message waiting indicators (MWIs), and to make telephone record and playback (TRAP) connections.

The following table describes the voice messaging port settings in Unity Connection that can be set on
Telephony Integrations > Port of Cisco Unity Connection Administration.

TIMG Integration Guide for Cisco Unity Connection Release 14
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Table 1: Settings for the Voice Messaging Ports

ConsiderationsField

Check this check box to enable the port. The port is
enabled during normal operation.

Uncheck this check box to disable the port. When the
port is disabled, calls to the port get a ringing tone but
are not answered. Typically, the port is disabled only
by the installer during testing.

Enabled

Enter the extension for the port as assigned on the
phone system.

Extension

Check this check box to designate the port for
answering calls. These calls can be incoming calls
from unidentified callers or from users.

Answer Calls

Check this check box to designate the port for
notifying users of messages. Assign PerformMessage
Notification to the least busy ports.

Perform Message Notification

For serial integrations, uncheck this check box.
Otherwise, the integration may not function correctly.

For in-band integrations, check this check box to
designate the port for turning MWIs on and off.
Assign Send MWI Requests to the least busy ports.

Send MWI Requests

(not used by serial integrations)

Check this check box so that users can use the phone
as a recording and playback device in
Unity Connection web applications. Assign Allow
TRAP Connections to the least busy ports.

Allow TRAP Connections

Enter the priority order in which Unity Connection
use the ports when dialing out (for example, if the
Perform Message Notification, Send MWI Requests,
or Allow TRAP Connections check box is checked).
The highest numbers are used first. However, when
multiple ports have the same Outgoing Hunt Order
number, Unity Connection use the port that has been
idle the longest.

Outgoing Hunt Order

Determining the Number of Voice Messaging Ports
The following tasks describe the process for determining the number of voice messaging ports for Cisco Unity
Connection to install, answer call and dial out calls:

• For determining the number of voice messaging ports to Install, see Voice Messaging Ports to Install.

• For determining the number of voice messaging ports to Answer Calls, see Voice Messaging Ports to
Answer Calls.
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• For determining the number of voice messaging ports to Dial Out, see Voice Messaging Ports that Dial
Out.

Voice Messaging Ports to Install
The number of voice messaging ports to install depends on numerous factors, including:

• The number of calls Unity Connection answer when call traffic is at its peak.

• The expected length of each message that callers record and that users listen.

• The number of users.

• The number of ports that be set to dial out only.

• The number of calls made for message notification.

• The number of MWIs activated when call traffic is at its peak.

• The number of TRAP connections needed when call traffic is at its peak. (TRAP connections are used
by Unity Connection web applications to play back and record over the phone).

• The number of calls use the automated attendant and call handlers when call traffic is at its peak.

• Whether a Unity Connection cluster is configured. For considerations, see the "Considerations for a
Unity Connection Cluster" section.

It is best to install only the number of voice messaging ports that are needed so that system resources are not
allocated to unused ports.

Voice Messaging Ports to Answer Calls
The calls that the voice messaging ports answer can be incoming calls from unidentified callers or from users.
Typically, the voice messaging ports that answer calls are the busiest.

You can set voice messaging ports to both answer calls and to dial out (for example, to send message
notifications). However, when the voice messaging ports perform more than one function and are very active
(for example, answering many calls), the other functions may be delayed until the voice messaging port is
free (for example, message notifications cannot be sent until there are fewer calls to answer). For best
performance, dedicate certain voice messaging ports for only answering incoming calls, and dedicate other
ports for only dialing out. Separating these port functions eliminates the possibility of a collision, in which
an incoming call arrives on a port at the same time that Unity Connection takes the port off-hook to dial out.

If your system is configured for a Unity Connection cluster, see the "Considerations for a Unity Connection
Cluster" section..

Voice Messaging Ports that Dial Out
Ports that only dial out and do not answer calls can do one or more of the following:

• Notify users by phone, pager, or email of messages that have arrived.

• Turn MWIs on and off for user extensions.

• Make a TRAP connection so that users can use the phone as a recording and playback device in
Cisco Unity Connection web applications.

TIMG Integration Guide for Cisco Unity Connection Release 14
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Typically, these voice messaging ports are the least busy ports.

If your system is configured for a Unity Connection cluster, see the "Considerations for a Unity Connection
Cluster" section.

In programming the phone system, do not send calls to voice messaging ports in Cisco Unity Connection that
cannot answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging
port is set only to Perform Message Notification, do not send calls to it.

Caution

Considerations for a Unity Connection Cluster
If your system is configured for a Unity Connection cluster, consider how the voice messaging ports used in
different scenarios.

When Both Unity Connection Servers are Functioning
• The number of ports provisioned on the phone system is the same as the number of voice messaging
ports on each Unity Connection server.

• The TIMG units are configured to send incoming calls first to the subscriber server, then to the publisher
server if no answering ports are available on the subscriber server.

• Both Unity Connection servers are active and handle voice messaging traffic for the system.

• The number of voice messaging ports on each Unity Connection server must be sufficient to handle all
of the voice messaging traffic for the system (answering calls and dialing out) when the other
Unity Connection server stops functioning.

If both Unity Connection servers must be functioning to handle the voice messaging traffic, the system do
not have sufficient capacity when one of the servers stops functioning.

• Each Unity Connection server must have voice messaging ports that answer calls and that can dial out
(for example, to set MWIs).

When Only One Unity Connection Server is Functioning
• TIMG units send all calls to the functioning Unity Connection server.

• The functioning Unity Connection server receives all voice messaging traffic for the system.

• The number of voice messaging ports that are assigned to the functioning Unity Connection server must
be sufficient to handle all of the voice messaging traffic for the system (answering calls and dialing out).

• The functioning Unity Connection server must have voice messaging ports that answer calls and that
can dial out (for example, to set MWIs).

If the functioning Unity Connection server does not have voice messaging ports for answering calls, the system
is not able to answer incoming calls. Similarly, if the functioning Unity Connection server does not have voice
messaging ports for dialing out, the system is not able to dial out (for example, to set MWIs).

TIMG Integration Guide for Cisco Unity Connection Release 14
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C H A P T E R 3
Setting Up an Avaya Definity G3 In-Band TIMG
Integration with Cisco Unity Connection

For detailed instructions for setting up an Avaya Definity G3 in-band TIMG integration with Cisco Unity
Connection, see the following sections in this chapter:

• Setting Up an Avaya Definity G3 In-Band TIMG Integration with Cisco Unity Connection, on page 9

Setting Up an Avaya Definity G3 In-Band TIMG Integration with
Cisco Unity Connection

For detailed instructions for setting up an Avaya Definity G3 in-band TIMG integration with Cisco Unity
Connection, see the following sections in this chapter:

Task List to Create an Avaya Definity G3 In-Band TIMG Integration
Before doing the following tasks to integrate Unity Connection with the phone system using the T1 media
gateway (TIMG), confirm that the Unity Connection server is ready for the integration after completing the
installation following the steps as mentioned in the "Installing Cisco Unity Connection" chapter of the Install,
Upgrade, and Maintenance Guide for Cisco Unity Connection , Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html.

1. Review the system and equipment requirements to confirm that all phone system and Unity Connection
server requirements have been met. See the Requirements section.

2. Plan how the voice messaging ports used by Unity Connection. See the Planning the Usage of Voice
Messaging Ports in Cisco Unity Connection chapter.

3. Program the phone system and extensions. See the Programming Phone System for In-Band TIMG
Integration section.

4. Set up the TIMG units for an in-band integration. See the Setting Up the TIMG Units section.

5. Create the integration. See the Creating an Integration with the Phone System section.

6. Test the integration. See the Testing the Integration chapter.

7. If this integration is a second or subsequent integration, add the applicable new user templates for the new
phone system. See the Adding New User Templates for Multiple Integrations chapter.

TIMG Integration Guide for Cisco Unity Connection Release 14
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Requirements
The Avaya Definity G3 in-band TIMG integration supports configurations of the following components:

Phone System
• Avaya Definity G3 phone system.

• T1 digital trunk interface card.

• One or more TIMG units (media gateways).

• The voice messaging ports in the phone system connected by T1 digital lines (DS1 or “dry T1” digital
lines only) to the ports on the TIMG units.

T1 (or “wet T1”) connections to the PSTN must be through an MTU, CSU, or
other device that provides line isolation. Otherwise, the TIMG units may be
damaged

Caution

• The TIMG units connected to the same LAN or WAN that Unity Connection is connected to.

• If the TIMG units connect to a WAN, the requirements for the WAN network connections are:

• For G.729a codec formatting, a minimum of 32.76 Kbps guaranteed bandwidth for each voice
messaging port.

• For G.711 codec formatting, a minimum of 91.56 Kbps guaranteed bandwidth for each voice
messaging port.

• No network devices that implement network address translation (NAT).

• A maximum 200 ms one-way one-way network latency.

• The phone system ready for the integration, as described in the documentation for the phone system.

Unity Connection Server
• Unity Connection installed and ready for the integration after completing the installation following the
steps as mentioned in the Installing Cisco Unity Connection chapter of the Install, Upgrade, and
Maintenance Guide for Cisco Unity Connection, Release 11.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/11x/install_upgrade/guide/b_11xcuciumg.html

• A license that enables the applicable number of voice messaging ports.

Centralized Voice Messaging
Unity Connection supports centralized voice messaging through the phone system, which supports various
inter-phone system networking protocols including proprietary protocols such as Avaya DCS, Nortel MCDN,
or Siemens CorNet, and standards-based protocols such as QSIG or DPNSS. Note that centralized voice
messaging is a function of the phone system and its inter-phone system networking, not voicemail. Unity
Connection supports centralized voice messaging as long as the phone system and its inter-phone system
networking are properly configured.

TIMG Integration Guide for Cisco Unity Connection Release 14
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Programming Phone System for In-Band TIMG Integration
If you use programming options other than those supplied in the following procedure, the performance of the
integration may be affected.

In programming the phone system, do not send calls to voice messaging ports in Unity Connection that cannot
answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging port
is set only to Perform Message Notification, do not send calls to it.

Caution

Step 1 Create a coverage path which contains the TIMG unit hunt group number as the coverage point.
Step 2 Assign the coverage path that you created in Step 1 to the user stations that must forward to the voice messaging ports

on the TIMG units when calls are not answered or when the user station is busy, based on one of the call transfer types
shown in Table 3-1.

Table 2: Call Transfer Types

UsageTransfer Type

Program the user station to forward calls to the pilot number
when:

• The extension is busy.

• The call is not answered.

Release transfer

(blind transfer)

Program the user station to forward calls to the pilot number
only when the call is not answered (on the phone system,
the number of rings before forwarding must be more than
the number of rings to supervise the call). Confirm that call
forwarding is disabled when the extension is busy.

Supervised transfer

Step 3 Assign an extension number for each voice messaging port, which is a digital line that connects to the TIMG unit, and
set the voice messaging port options as shown in Table 3-2.

You should distribute the voice messaging ports among multiple phone system line cards so that call processing
can continue even if a line card becomes inactive.

Note

Table 3: Voice Messaging Port Options for All Lines

SettingOption

Enter the extension number of the digital line.Extension

Enter the applicable setting:

• VMI

• VMIFD

Type

Enter 4.Loss Group

TIMG Integration Guide for Cisco Unity Connection Release 14
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SettingOption

Enter y.Off Premises Station

Enter n.R Balance Network

Enter internal.Survivable COR

Enter y.Survivable Trunk Dest

Enter y.LWC Activation

Enter n.LWC Log External Calls

Enter n.CDR Privacy

Enter y.Redirect Notification

Enter n.Per Button Ring Control

Enter n.Bridged Call Alerting

Enter y.Switch hook Flash

Enter n.Ignore Rotary Digits

Enter n.H.320 Conversion

Enter as-needed.Service Link Mode

Enter basic.Multimedia Mode

Enter y.Coverage Message Retrieval

Enter none.Auto Answer

Enter n.Data Restriction

Enter y.Distinctive Audible Alert

Enter y.Adjunct Supervision

Enter n.Audible Message Waiting

Enter s.Coverage After Forwarding

Enter n.Multimedia Early Answer

Enter call-appr.LWC Appearance

Step 4 Set the DS1 Circuit Pack options as shown in Table 3-3.

TIMG Integration Guide for Cisco Unity Connection Release 14
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Table 4: DS1 Circuit Pack Options

SettingOption

Enter 1.Line Compensation

Enter robbed-bit.Signaling Mode

Enter b8zs.Line Coding

Enter esf.Framing Mode

Enter mulaw.Interface Companding

Enter 11111111.Idle Code

Enter n.Slip Detection

Enter n.Echo Cancellation

Enter other.Near-end CSU Type

Step 5 Assign a the voice messaging ports to a hunt group by setting the options shown in Table 3-4.

Table 5: Hunt Group Options

SettingOption

Enter none.LWC Reception

Enter none.Message Center

Enter the hunt group number.Group Number

Enter the pilot number for the hunt group.Group Extension

Enter ucd-mia.Group Type

Enter the display name for the hunt group.Group Name

Enter n.Queue?

Step 6 Enter the group member assignments for the voice messaging ports that answer calls and press Enter.
If you plan to set the voice messaging ports to either answer calls or to dial out (for example, to set MWIs), make sure
that you include in the hunt group only the voice messaging ports are set to answer calls.
For smaller systems, include in the hunt group all voice messaging ports when the ports are set to both answer calls and
dial out (for example, to set MWIs).

Setting Up the TIMG Units
Do the following procedures to set up the TIMG units (media gateways) that are connected to the phone
system.

TIMG Integration Guide for Cisco Unity Connection Release 14
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These procedures require that the following tasks have already been completed:

• The phone system is connected to the TIMG units using T1 digital lines.
• The TIMG units are connected to a power source.
• The TIMG units are ready to be connected to the LAN or WAN.

Because TIMG units have the same default IP address, you must set them up one at a time. Otherwise, you
can experience IP address conflicts.

Caution

Fields that are not mentioned in the following procedures must keep their default values. For the default values
of all fields, see the manufacturer documentation for the TIMG units.

Step 1 On a Windows workstation that have access to the TIMG units, go to the following link:
http://software.cisco.com/download/navigator.html?mdfid=280082558&i=rm.

To access the software download page, you must be signed in to Cisco.com as a registered user.

This procedure describes the steps when using Internet Explorer as your web browser. If you are using a
different web browser, the steps may differ.

Note

Step 2 In the tree control on the Downloads Home page, expand Unified Communications> Unified Communications
Applications > Messaging > Cisco Unity and select Cisco Unity Telephony Integration.

Step 3 On the Log In page, enter your username and password, then select Log In.
Step 4 On the Select a Release page, under Latest Releases, select the most recent release.
Step 5 In the right column, select the version of the firmware for your TIMG units.
Step 6 On the Download Image page, select Download.
Step 7 On the Supporting Document(s) page, select Agree.
Step 8 In the File Download dialog box, select Save.
Step 9 In the Save As dialog box, browse to the Windows workstation that have access the TIMG units, browse to a directory

where you want to save the file, and select Save.
Step 10 In the Download Complete dialog box, selectOpen. The window for extracting the TIMG firmware update files appears.
Step 11 Select Extract.
Step 12 In the Extract dialog box, browse to the directory where you want the extracted files, and select Extract.
Step 13 Close the window for the extracting application.

Setting Up the TIMG Units (Firmware Version 6.x)

Step 1 On the Windows workstation, add a temporary route to enable access to the TIMG units.
a) On the Windows Start menu, select Run.
b) Enter cmd, and press Enter. The Command Prompt window appears.
c) At the command prompt, enter route add 10.12.13.74 <IP Address of Workstation>, and press Enter.

For example, if the IP address of the workstation is 198.1.3.25, enter “route add 10.12.13.74<space>198.1.3.25”
in the Command Prompt window.

TIMG Integration Guide for Cisco Unity Connection Release 14
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d) Close the Command Prompt window.

Step 2 Connect a TIMG unit to the network.
Step 3 In the web browser, go to http://10.12.13.74.
Step 4 To sign in, enter the following case-sensitive settings.

Table 6: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

Step 5 Select OK.
Step 6 On the System menu, select Upgrade.
Step 7 On the Upgrade page, under Browse for Upgrade File, select Browse.
Step 8 In the Choose File dialog box, browse to the directory on theWindows workstation that has the extracted TIMG firmware

update files.
Step 9 Select T1E1_<xx > .app (where <xx> is multiple digits), and select Open.
Step 10 On the Upgrade page, select Install File.
Step 11 After the file is installed, a message prompting you to restart the TIMG unit appears. Select Cancel.

Do not restart the TIMG unit until you are instructed to do so later in this procedure, even if the file installation
fails. Restarting the TIMG unit at this step may prevent the TIMG unit from functioning correctly.

Caution

Step 12 Repeat Step 6 through Step 11 for the following files:

• T1E1_<xx>.fsh

• T1E1_<xx>.msd

Step 13 On the Configuration menu, select Import/Export.
Step 14 On the Import/Export page, select Browse.
Step 15 In the Choose File dialog box, browse to the file T1_LS_Cfg_LucentG3.ini.
Step 16 Select T1_LS_Cfg_LucentG3.ini, and select Open.
Step 17 On the Import/Export page, select Import File.
Step 18 After the file is imported, a message prompting you to restart the TIMG unit appears. Select OK.
Step 19 In the web browser, go to http://10.12.13.74.
Step 20 To sign in, enter the following case-sensitive settings.

Table 7: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

Step 21 Select OK.
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Step 22 On the System menu, select Password.
Step 23 On the Change Password page, enter the following settings.

Table 8: Change Password Page Settings

SettingField

Enter IpodAdmin. (This setting is case sensitive.)Old Password

Enter your new password. (This setting is case sensitive.)New Password

Enter your new password. (This setting is case sensitive.)Confirm Password

Step 24 Select Change.
Step 25 On the Configuration menu, select Mgmt Protocols.
Step 26 On the Management Protocols page, enter the following settings.

Table 9: Management Protocols Page Settings

SettingsField

Select No.E-mail Alarms Enabled

Select No.SNMP Traps Enabled

Select Yes.HTTP Server Enabled

Select No.HTTPs Server Enabled

Step 27 Select Submit.
Step 28 On the Configuration menu, select Routing Table.
Step 29 On the Routing Table page, under Router Configuration, select VoIP Host Groups.
Step 30 Under VoIP Host Groups, enter the following settings for the first VoIP Host Group.

Table 10: First VoIP Host Group Settings

SettingsField

Accept the default or enter another descriptive name of
the VoIP host group.

Name

(Unity Connection without a cluster) Select False.

(Unity Connection with a cluster configured) Select False.

Load-Balanced

(Unity Connection without a cluster) Select False.

(Unity Connection with a cluster configured) Select True.

Fault-Tolerant

Step 31 For Unity Connection without a cluster, under Host List, enter the host name or IP address of the Unity Connection
server and the server port in the format <host name or IP address>:5060.
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For Unity Connection with a cluster configured, under Host List, enter the host name or IP address of the subscriber
server (the second Unity Connection server that you installed) and the server port in the format <host name or IP
address>:5060.

Step 32 For Unity Connection without a cluster, continue to Step 34. For Unity Connection with a cluster configured, select
Add Host.

Step 33 In the second field, enter the host name or IP address of the publisher server (the first Unity Connection server that you
installed) and the server port in the format <host name or IP address>:5060.

Do not add a third host under Host List or a second host group under VoIP Host Groups. Otherwise, the Unity
Connection cluster may not function correctly.

Note

Step 34 Select Submit.
Step 35 On the Configuration menu, select TDM > T1/E1.
Step 36 On the T1/E1 Configuration page, enter the following settings.

Table 11: T1/E1 Configuration Page Settings

SettingsField

Line Settings

Select T1.Line Mode

Select CAS.Signaling Mode

Select Terminal.Interface Mode

T1 Line

Select B8ZS.Line Encoding

Select EFS.Framing

Select Short_Haul_110ft.Selects Transmit Pulse Waveform

T1 CAS Protocol

Select Loop_Start.T1 CAS Protocol

Enter 550.Flash Hook

Enter !!.Consult Call Dialtone Drop Code

Enter !!.Consult Call Proceeding Drop Code

Enter !.Consult Call Busy Drop Code

Enter !!.Consult Call Error Drop Code

Enter ,,,,.Consult Call Connected Drop Code

Enter !.Consult Call Disconnected Drop Code

Select No.MWI confirmation Tone
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SettingsField

Select TypeII_CPID.CPID Type

Enter 5000.Initial Wait for Inband CPID

Enter 500.Inband CPID Complete Timeout

Failover Settings

Select No.Enable Failover

Step 37 Select Submit.
Step 38 On the Configuration menu, select TDM > General.
Step 39 On the TDM General Settings page, enter the following settings.

Table 12: TDM General Settings Page Settings

SettingsField

Select uLaw.PCM Coding

Enter 500.Minimum Call Party Delay (ms)

Enter 2000.Maximum Call Party Delay (ms)

Enter 100.Dial Digit on Time (ms)

Enter 100.Dial Inter-Digit Time (ms)

Enter 2000.Dial Pause Time (ms)

Enter the code that the phone system uses to turn MWIs
on.

Turn MWI On FAC

Enter the code that the phone system uses to turn MWIs
off.

Turn MWI Off FAC

Enter 10000.Outbound Call Connect Timeout (ms)

Select Yes.Wait for Ringback/Connect on Blind Transfer

Enter the pilot number of the Unity Connection voice
messaging ports.

Hunt Group Extension

Step 40 Select Submit.
Step 41 On the Configuration menu, select TDM > Port Enable.
Step 42 On the TDM Port Enabling page, select No for the ports that you want to disable on the TIMG unit.
Step 43 Confirm that Yes is selected for all other ports on the TIMG unit.
Step 44 Select Submit.
Step 45 On the Configuration menu, select VoIP > General.
Step 46 On the VoIP General Settings page, enter the following settings.
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Table 13: VoIP General Settings Page Settings

SettingField

User-Agent

Enter the domain name of the TIMG unit.Host and Domain Name

Select UDP.Transport Type

Select No.Call as Domain Name

Select No.SIPS URI Scheme Enabled

Enter 120.Invite Expiration (sec)

Server

Enter the IP Address of the Domain Name Server that the
TIMG unit uses.

DNS Server Address

Leave this field blank.Registration Server Address

Enter 5060.Registration Server Port

Enter 3600.Registration Expiration (sec)

TCP/UDP

Select Yes.UDP/TCP Transports Enabled

Enter 5060.TCP/UDP Server Port

Proxy

Leave this field blank.Primary Proxy Server Address

Not applicable. Leave the default setting.Primary Proxy Server Port

Not applicable. Leave the default setting.Backup Proxy Server Address

Not applicable. Leave the default setting.Backup Proxy Server Port

Enter 10.Proxy Query Interval

Timing

Enter 500.T1 Time

Enter 4000.T2 Time

Enter 5000.T4 Time

Monitoring

Select No.Monitor Call Connections
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Step 47 Select Submit.
Step 48 On the Configuration menu, select VoIP > Media.
Step 49 On the VoIP Media Settings page, enter the following settings.

Table 14: VoIP Media Settings Page Settings

SettingsField

Audio

Select the preferred codec for audio compression:

• G.711u—The TIMGunit uses only the G.711mu-law
codec.

• G.729AB—The TIMG unit prefers the G.729 codec
but can also use the G.711 mu-law codec.

Audio Compression

Select RFC2833.RTP Digit Relay Mode

Select Off.Signaling Digit Relay Mode

Select On.Voice Activity Detection

Select the applicable setting:

• G.711—20

• G.729AB—10

Failure to use the correct setting results in
recorded messages containing nothing but
silence.

Caution

Frame Size

Select the applicable setting:

• G.711—1

• G.729AB—2

Failure to use the correct setting results in
recorded messages containing nothing but
silence.

Caution

Frames Per Packet

Step 50 Select Submit.
Step 51 On the Configuration menu, select VoIP > QOS.
Step 52 On the VoIP QOS Configuration page, enter the following settings.

Table 15: VoIP QOS Configurative Page Settings

SettingsField

Enter 104 (equivalent to DSCP AF31).Call Control QOS Byte
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SettingsField

Enter 184 (equivalent to DSCP EF).RTP QOS Byte

Step 53 Select Submit.
Step 54 On the Configuration menu, select IP.
Step 55 On the IP Settings, LAN1 page, enter the following settings.

Table 16: IP Settings, LAN1 Page Settings

SettingsField

Enter the new IP address that you want to use for the TIMG
unit.

(This is the IP address that you enter in Cisco Unity
Connection Administration when you create the
integration.)

Client IP Address

Enter the new subnet mask, if the subnet mask is different
from the default IP address.

Client Subnet Mask

Enter the IP address of the default network gateway router
that the TIMG units use.

Default Network Gateway Address

If you are using DHCP, select Yes.

If you are not using DHCP, select No.

BOOTP Enabled

Step 56 Select Submit.
Step 57 On the Configuration menu, select Tone Detection.
Step 58 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn Tone Event field, select Busy and do the

following substeps to verify that the tone is correct.
a) From a available phone, call a second phone.
b) Answer the second phone when it rings, and leave both handsets off so that both phones are busy.
c) From a third phone, dial one of the busy phones.
d) Confirm that you hear a busy tone.
e) Hang up the third phone but leave the handsets for the other two phones off.

Step 59 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 58c from the third
phone.

Step 60 Select Learn.
Step 61 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, select Error and do the following

substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does not exist.
b) Confirm that you hear the reorder or error tone.
c) Hang up the phone.

Step 62 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 61a
Step 63 Select Learn.
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Step 64 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, selectRingback and do the following
substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does exist.
b) Confirm that you hear the ringback tone.
c) Hang up the phone.

Step 65 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 64a
Step 66 Select Learn.
Step 67 Select Submit.
Step 68 Hang up the phones that you used in Step 58.
Step 69 On the Configuration menu, select Import/Export.
Step 70 On the Import/Export page, under Export Files, select Export All Settings.
Step 71 In the File Download dialog box, select Save.
Step 72 In the Save As dialog box, browse to theWindows workstation that has access to the TIMG units, browse to a directory

where you want to save the file, and select Save.
Step 73 In the Download Complete dialog box, select Open. Notepad opens the file Config.ini that you saved.
Step 74 Locate the line with the following parameter:

telautoanswer

Step 75 Confirm that the value of the parameter is no so that the line reads as follows:

telautoanswer = no

Step 76 Locate the line with the following parameter:

telFacCDropProc

Step 77 Confirm that the value of the parameter is !! so that the line reads as follows:

telFacCDropProc = !!

The telFacCDropProc parameter must be set to !!. If the telFacCDropProc parameter is set to 1, supervised
transfers fail, and the caller hears the called party standard greeting two times.

Caution

Step 78 Save the file, and exit Notepad.
Step 79 On the Configuration menu of the TIMG unit, select Import/Export.
Step 80 On the Import/Export page, under Browse for Import File, select Browse.
Step 81 In the Choose File dialog box, browse to the file Config.ini that you saved.
Step 82 Select Config.ini, and select Open.
Step 83 On the Import/Export page, select Import File.
Step 84 When prompted to restart the TIMG unit, select OK.
Step 85 Repeat Step 2 through Step 84 on all remaining TIMG units.
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Creating an Integration with the Phone System
After ensuring that the phone system, the TIMG units and the Unity Connection server are ready for the
integration, do the following procedures to set up the integration and to enter the port settings.

Step 1 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 2 On the Search Phone Systems page, under Display Name, select the name of the default phone system.
Step 3 On the Phone System Basics page, in the Phone System Name field, enter the descriptive name that you want for the

phone system.
Step 4 If you want to use this phone system as the default for TRaP connections so that administrators and users without

voicemail boxes can record and playback through the phone in Unity Connection web applications, check the Default
TRAP Switch check box. If you want to use another phone system as the default for TRaP connections, uncheck this
check box.

Step 5 Select Save.
Step 6 On the Phone System Basics page, in the Related Links drop-down box, select Add Port Group and select Go.
Step 7 On the New Port Group page, enter the applicable settings and select Save.

Table 17: Settings for the New Port Group Page

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG in the drop-down box.

Create From

Enter a descriptive name for the port group. You can accept
the default name or enter the name that you want.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the TIMG unit that you are
integrating with Unity Connection.

IPv4 Address or Host Name

Do not enter a value in this field. IPv6 is not supported for
TIMG integrations.

IPv6 Address or Host Name

Enter the IP address of the TIMG unit that you are
integrating with Unity Connection.

IP Address or Host Name

TIMG Integration Guide for Cisco Unity Connection Release 14
23

Setting Up an Avaya Definity G3 In-Band TIMG Integration with Cisco Unity Connection
Creating an Integration with the Phone System



SettingField

Enter the SIP port of the TIMG unit that Unity Connection
connects to. You should use the default setting.

This name must match the setting in the
TCP/UDP Server Port field on the
Configuration > VoIP > General page of the
TIMG unit. Otherwise, the integration do not
function correctly.

Caution

Port

Step 8 On the Port Group Basics page, in the Related Links drop-down box, select Add Ports and select Go.
Step 9 On the New Port page, enter the following settings and select Save.

Table 18: Settings for the New Ports Page

ConsiderationsField

Check this check box.Enabled

Enter the number of voice messaging ports that you want
to create in this port group.

For a Unity Connection cluster, the server must
have the number of voice messaging ports that
are set up on the phone system for the TIMG
integration so that this server can handle all
voice messaging traffic for the cluster if one of
the servers stops functioning. For example, if
the phone system is set up with 16 voice
messaging ports, this server must have 16 voice
messaging ports.

Note

Number of Ports

Select the name of the phone system that you entered in
Step 3.

Phone System

Select the name of the port group that you added in Step 7.Port Group

Step 10 On the Search Ports page, select the display name of the first voice messaging port that you created for this phone
system integration.

By default, the display names for the voice messaging ports are composed of the port group display name
followed by incrementing numbers.

Note

Step 11 On the Port Basics page, set the voice messaging port settings as applicable. The fields in the following table are the
ones that you can change.
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Table 19: Settings for the Voice Messaging Ports

ConsiderationsField

Check this check box to enable the port. The port is enabled
during normal operation.

Uncheck this check box to disable the port. When the port
is disabled, calls to the port get a ringing tone but are not
answered. Typically, the port is disabled only by the
installer during testing.

Enabled

Enter the extension for the port as assigned on the phone
system.

Extension

Check this check box to designate the port for answering
calls. These calls can be incoming calls from unidentified
callers or from users.

Answer Calls

Check this check box to designate the port for notifying
users of messages. Assign Perform Message Notification
to the least busy ports.

Perform Message Notification

Check this check box to designate the port for turning
MWIs on and off. Assign Send MWI Requests to the least
busy ports.

Send MWI Requests

Check this check box so that users can use the port for
recording and playback through the phone in Unity
Connection web applications. Assign Allow TRAP
Connections to the least busy ports.

Allow TRAP Connections

Enter the priority order in which Unity Connection use the
ports when dialing out (for example, if the Perform
Message Notification, Send MWI Requests, or Allow
TRAP Connections check box is checked). The highest
numbers are used first. However, whenmultiple ports have
the same Outgoing Hunt Order number, Unity Connection
use the port that has been idle the longest.

Outgoing Hunt Order

Step 12 Select Save.
Step 13 Select Next.
Step 14 Repeat Step 11 through Step 13 for all remaining voice messaging ports for the phone system.
Step 15 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 16 On the Search Phone Systems page, under Display Name, select the name of the phone system that you entered in

Step 3.
Step 17 Repeat Step 6 through Step 16 for each remaining TIMG unit integrated with Unity Connection.

Each TIMG unit is connected to one port group with the applicable voice messaging ports. For example, a
system that uses two TIMG units requires two port groups, one port group for each TIMG unit.

Note

Step 18 If another phone system integration exists, in Cisco Unity Connection Administration, expandTelephony Integrations,
then select Trunk. Otherwise, skip to Step 22.
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Step 19 On the Search Phone System Trunks page, on the Phone System Trunk menu, select New Phone System Trunk.
Step 20 On the New Phone System Trunk page, enter the following settings for the phone system trunk and select Save.

Table 20: Settings for the Phone System Trunk

SettingField

Enter the display name of the phone system that you are
creating a trunk for.

From Phone System

Enter the display name of the previously existing phone
system that the trunk connects to.

To Phone System

Enter the extra digits that Unity Connection must dial to
transfer calls through the gateway to extensions on the
previously existing phone system.

Trunk Access Code

Step 21 Repeat Step 19 and Step 20 for all remaining phone system trunks that you want to create.
Step 22 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Port Group.
Step 23 On the Search Port Groups page, select the display name of the port group that you added in Step 7.
Step 24 On the Port Group Basics page, select Reset.
Step 25 When prompted that resetting terminates all call traffic, select OK.
Step 26 In the Related Links drop-down list, select Check Telephony Configuration and select Go to confirm the phone

system integration settings.

If the test is not successful, the Task Execution Results displays one or more messages with troubleshooting steps. After
correcting the problems, test the connection again.

Step 27 In the Task Execution Results window, select Close.
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C H A P T E R 4
Setting Up an Avaya S8500/S8700 In-Band TIMG
Integration with Cisco Unity Connection

• Introduction, on page 27
• Task List to Create an Avaya S8500/S8700 In-Band TIMG Integration, on page 27
• Requirements, on page 28
• Programming Phone System for In-Band TIMG Integration, on page 29
• Setting Up the TIMG Units, on page 32
• Creating an Integration with the Phone System, on page 41

Introduction
This chapter contains detailed instructions for setting up an Avaya S8500/S8700 in-band TIMG integration
with Cisco Unity Connection,

Caller ID is supported for internal callers only. The Avaya S8500/S8700 phone system does not support caller
ID for external callers.

Note

Task List to Create an Avaya S8500/S8700 In-Band TIMG
Integration

Before doing the following tasks to integrate Unity Connection with the phone system using the T1 media
gateway (TIMG), confirm that the Cisco Unity Connection server is ready for the integration after completing
the installation following the steps as mentioned in the “ "Installing Cisco Unity Connection"”chapter of the
Install, Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html

Review the system and equipment requirements to confirm that all phone system and Unity Connection server
requirements have been met. See the Requirements section.

1. Plan how the voice messaging ports used by Unity Connection. See the Planning the Usage of Voice
Messaging Ports in Cisco Unity Connection chapter.
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2. Program the phone system and extensions. See the Programming Phone System for In-Band TIMG
Integration section.

3. Set up the TIMG units for an in-band integration. See the Setting Up the TIMG Units section.

4. Create the integration. See the Creating an Integration with the Phone System section.

5. Test the integration. See the Testing the Integration chapter.

6. If this integration is a second or subsequent integration, add the applicable new user templates for the new
phone system. See the Adding New User Templates for Multiple Integrations chapter.

Requirements
The Avaya S8500/S8700 in-band TIMG integration supports configurations of the following components:

Phone System
• Avaya S8500/S8700 phone system.

• Software version Cisco Unified CallManager 2.0.

• T1 digital trunk interface card.

• One or more TIMG units (media gateways).

• The voice messaging ports in the phone system connected by T1 digital lines (DS1 or “dry T1” digital
lines only) to the ports on the TIMG units.

T1 (or “wet T1”) connections to the PSTN must be through an MTU, CSU, or other device that provides line
isolation. Otherwise, the TIMG units may be damaged.

Note

• The TIMG units connected to the same LAN or WAN that Unity Connection is connected to.

• If the TIMG units connect to a WAN, the requirements for the WAN network connections are:

• For G.729a codec formatting, a minimum of 32.76 Kbps guaranteed bandwidth for each voice
messaging port.

• For G.711 codec formatting, a minimum of 91.56 Kbps guaranteed bandwidth for each voice
messaging port.

• No network devices that implement network address translation (NAT).

• A maximum 200 ms one-way one-way network latency.

Unity Connection Server
The Avaya S8500/S8700 in-band TIMG integration supports configurations of the following components:
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• Unity Connection installed and ready for the integration after completing the installation following the
steps as mentioned in the Installing Cisco Unity Connectionchapter of the Install, Upgrade, and
Maintenance Guide for Cisco Unity Connection Release 11.x at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/11x/install_upgrade/guide/b_11xcuciumg.html.

• A license that enables the applicable number of voice messaging ports.

Centralized Voice Messaging
Unity Connection supports centralized voice messaging through the phone system, which supports various
inter-phone system networking protocols including proprietary protocols such as Avaya DCS, Nortel MCDN,
or Siemens CorNet, and standards-based protocols such as QSIG or DPNSS. Note that centralized voice
messaging is a function of the phone system and its inter-phone system networking, not voicemail. Unity
Connection supports centralized voice messaging as long as the phone system and its inter-phone system
networking are properly configured.

Programming Phone System for In-Band TIMG Integration
If you use programming options other than those supplied in the following procedure, the performance of the
integration may be affected.

In programming the phone system, do not send calls to voice messaging ports in Unity Connection that cannot
answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging port
is set only to Perform Message Notification, do not send calls to it.

Caution

SUMMARY STEPS

1. Create a coverage path which contains the TIMG unit hunt group number as the coverage point.
2. Assign the coverage path that you created in Step 1 to the user stations that must forward to the voice

messaging ports on the TIMG units when calls are not answered or when the user station is busy, based
on one of the call transfer types shown in Table 4-1.

3. Assign an extension number for each voice messaging port, which is a digital line that connects to the
TIMG unit, and set the voice messaging port options as shown in Table 4-2.

4. Set the DS1 Circuit Pack options as shown in Table 4-3.
5. Assign a the voice messaging ports to a hunt group by setting the options shown in Table 4-4.
6. Enter the group member assignments for the voice messaging ports that answer calls and press Enter.

DETAILED STEPS

Step 1 Create a coverage path which contains the TIMG unit hunt group number as the coverage point.
Step 2 Assign the coverage path that you created in Step 1 to the user stations that must forward to the voice messaging ports

on the TIMG units when calls are not answered or when the user station is busy, based on one of the call transfer types
shown in Table 4-1.
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Table 21: Call Transfer Types

UsageTransfer Type

Program the user station to forward calls to the pilot number
when:

• The extension is busy.

• The call is not answered.

Release transfer

(blind transfer)

Program the user station to forward calls to the pilot number
only when the call is not answered (on the phone system,
the number of rings before forwarding must be more than
the number of rings to supervise the call). Confirm that call
forwarding is disabled when the extension is busy.

Supervised transfer

Step 3 Assign an extension number for each voice messaging port, which is a digital line that connects to the TIMG unit, and
set the voice messaging port options as shown in Table 4-2.

You should distribute the voice messaging ports among multiple phone system line cards so that call processing
can continue even if a line card becomes inactive.

Note

Table 22: Voice Messaging Port Options for All Lines

SettingOption

Enter the extension number of the digital line.Extension

Enter the applicable setting:

• VMI

• VMIFD

Type

Enter 4.Loss Group

Enter y.Off Premises Station

Enter n.R Balance Network

Enter internal.Survivable COR

Enter y.Survivable Trunk Dest

Enter y.LWC Activation

Enter n.LWC Log External Calls

Enter n.CDR Privacy

Enter y.Redirect Notification

Enter n.Per Button Ring Control

Enter n.Bridged Call Alerting
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SettingOption

Enter y.Switch hook Flash

Enter n.Ignore Rotary Digits

Enter n.H.320 Conversion

Enter as-needed.Service Link Mode

Enter basic.Multimedia Mode

Enter y.Coverage Message Retrieval

Enter none.Auto Answer

Enter n.Data Restriction

Enter y.Distinctive Audible Alert

Enter y.Adjunct Supervision

Enter n.Audible Message Waiting

Enter s.Coverage After Forwarding

Enter n.Multimedia Early Answer

Enter call-appr.LWC Appearance

Step 4 Set the DS1 Circuit Pack options as shown in Table 4-3.

Table 23: DS1 Circuit Pack Options

SettingOption

Enter 1.Line Compensation

Enter robbed-bit.Signaling Mode

Enter b8zs.Line Coding

Enter esf.Framing Mode

Enter mulaw.Interface Companding

Enter 11111111.Idle Code

Enter n.Slip Detection

Enter n.Echo Cancellation

Enter other.Near-end CSU Type

Step 5 Assign a the voice messaging ports to a hunt group by setting the options shown in Table 4-4.
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Table 24: Hunt Group Options

SettingOption

Enter none.LWC Reception

Enter none.Message Center

Enter the hunt group number.Group Number

Enter the pilot number for the hunt group.Group Extension

Enter ucd-mia.Group Type

Enter the display name for the hunt group.Group Name

Enter n.Queue?

Step 6 Enter the group member assignments for the voice messaging ports that answer calls and press Enter.
If you plan to set the voice messaging ports to either answer calls or to dial out (for example, to set MWIs), make sure
that you include in the hunt group only the voice messaging ports are set to answer calls.
For smaller systems, include in the hunt group all voice messaging ports when the ports are set to both answer calls and
dial out (for example, to set MWIs).

Setting Up the TIMG Units
Do the following procedures to set up the TIMG units (media gateways) that are connected to the phone
system.

These procedures require that the following tasks have already been completed:

• The phone system is connected to the TIMG units using T1 digital lines.
• The TIMG units are connected to a power source.
• The TIMG units are ready to be connected to the LAN or WAN.

Because TIMG units have the same default IP address, you must set them up one at a time. Otherwise, you
can experience IP address conflicts.

Note

Fields that are not mentioned in the following procedures must keep their default values. For the default values
of all fields, see the manufacturer documentation for the TIMG units.

Downloading TIMG Firmware Update Files

Step 1 On a Windows workstation that have access to the TIMG units, go to the following link:
http://software.cisco.com/download/navigator.html?mdfid=280082558&i=rm.
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To access the software download page, you must be signed in to Cisco.com as a registered user.

This procedure describes the steps when using Internet Explorer as your web browser. If you are using a
different web browser, the steps may differ.

Note

Step 2 In the tree control on the Downloads Home page, expand Unified Communications> Unified Communications
Applications > Messaging > Cisco Unity and select Cisco Unity Telephony Integration.

Step 3 On the Log In page, enter your username and password, then select Log In.
Step 4 On the Select a Release page, under Latest Releases, select the most recent release.
Step 5 In the right column, select the version of the firmware for your TIMG units.
Step 6 On the Download Image page, select Download.
Step 7 On the Supporting Document(s) page, select Agree.
Step 8 In the File Download dialog box, select Save.
Step 9 In the Save As dialog box, browse to the Windows workstation that have access the TIMG units, browse to a directory

where you want to save the file, and select Save.
Step 10 In the Download Complete dialog box, selectOpen. The window for extracting the TIMG firmware update files appears.
Step 11 Select Extract.
Step 12 In the Extract dialog box, browse to the directory where you want the extracted files, and select Extract.
Step 13 Close the window for the extracting application.

Setting Up the TIMG Units (Firmware Version 6.x)

Step 1 On the Windows workstation, add a temporary route to enable access to the TIMG units.
a) On the Windows Start menu, select Run.
b) Enter cmd, and press Enter. The Command Prompt window appears.
c) At the command prompt, enter route add 10.12.13.74 <IP Address of Workstation>, and press Enter.

For example, if the IP address of the workstation is 198.1.3.25, enter “route add 10.12.13.74<space>198.1.3.25”
in the Command Prompt window.

d) Close the Command Prompt window.

Step 2 Connect a TIMG unit to the network.
Step 3 In the web browser, go to http://10.12.13.74.
Step 4 To sign in, enter the following case-sensitive settings.

Table 25: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

Step 5 Select OK.
Step 6 On the System menu, select Upgrade.
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Step 7 On the Upgrade page, under Browse for Upgrade File, select Browse.
Step 8 In the Choose File dialog box, browse to the directory on theWindows workstation that has the extracted TIMG firmware

update files.
Step 9 Select T1E1_<xx > .app (where <xx> is multiple digits), and select Open.
Step 10 On the Upgrade page, select Install File.
Step 11 After the file is installed, a message prompting you to restart the TIMG unit appears. Select Cancel.

Do not restart the TIMG unit until you are instructed to do so later in this procedure, even if the file installation
fails. Restarting the TIMG unit at this step may prevent the TIMG unit from functioning correctly.

Caution

Step 12 Repeat Step 6 through Step 11 for the following files:

• T1E1_<xx>.fsh

• T1E1_<xx>.msd

Step 13 On the Configuration menu, select Import/Export.
Step 14 On the Import/Export page, select Browse.
Step 15 In the Choose File dialog box, browse to the file T1_LS_Cfg_Avaya8500.ini.
Step 16 Select T1_LS_Cfg_Avaya8500.ini, and select Open.
Step 17 On the Import/Export page, select Import File.
Step 18 After the file is imported, a message prompting you to restart the TIMG unit appears. Select OK.
Step 19 In the web browser, go to http://10.12.13.74.
Step 20 To sign in, enter the following case-sensitive settings.

Table 26: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

Step 21 Select OK.
Step 22 On the System menu, select Password.
Step 23 On the Change Password page, enter the following settings.

Table 27: Change Password Page Settings

SettingField

Enter IpodAdmin.

(This setting is case sensitive.)

Old Password

Enter your new password.

(This setting is case sensitive.)

New Password

Enter your new password.

(This setting is case sensitive.)

Confirm Password
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Step 24 Select Change.
Step 25 On the Configuration menu, select Mgmt Protocols.
Step 26 On the Management Protocols page, enter the following settings.

Table 28: Management Protocols Page Settings

SettingsField

Select No.E-mail Alarms Enabled

Select No.SNMP Traps Enabled

Select Yes.HTTP Server Enabled

Select No.HTTPs Server Enabled

Step 27 Select Submit.
Step 28 On the Configuration menu, select Routing Table.
Step 29 On the Routing Table page, under Router Configuration, select VoIP Host Groups.
Step 30 Under VoIP Host Groups, enter the following settings for the first VoIP Host Group.

Table 29: First VoIP Host Group Settings

SettingsField

Accept the default or enter another descriptive name of
the VoIP host group.

Name

(Unity Connection without a cluster) Select False.

(Unity Connection with a cluster configured) Select False.

Load-Balanced

(Unity Connection without a cluster) Select False.

(Unity Connection with a cluster configured) Select True.

Fault-Tolerant

Step 31 For Unity Connection without a cluster, under Host List, enter the host name or IP address of the Unity Connection
server and the server port in the format <host name or IP address>:5060.

For Unity Connection with a cluster configured, under Host List, enter the host name or IP address of the subscriber
server (the second Unity Connection server that you installed) and the server port in the format <host name or IP
address>:5060.

Step 32 For Unity Connection without a cluster, continue to Step 34. For Unity Connection with a cluster configured, select
Add Host.

Step 33 In the second field, enter the host name or IP address of the publisher server (the first Unity Connection server that you
installed) and the server port in the format <host name or IP address>:5060.

Do not add a third host under Host List or a second host group under VoIP Host Groups. Otherwise, the Unity
Connection cluster may not function correctly.

Caution

Step 34 Select Submit.
Step 35 On the Configuration menu, select TDM > T1/E1.
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Step 36 On the T1/E1 Configuration page, enter the following settings.

Table 30: T1/E1 Configuration Page Settings

SettingsField

Line Settings

Select T1.Line Mode

Select CAS.Signaling Mode

Select Terminal.Interface Mode

T1 Line

Select B8ZS.Line Encoding

Select EFS.Framing

Select Short_Haul_110ft.Selects Transmit Pulse Waveform

T1 CAS Protocol

Select Loop_Start.T1 CAS Protocol

Enter 550.Flash Hook

Enter !!.Consult Call Dialtone Drop Code

Enter !!.Consult Call Proceeding Drop Code

Enter !.Consult Call Busy Drop Code

Enter !!.Consult Call Error Drop Code

Enter ,,,,.Consult Call Connected Drop Code

Enter !.Consult Call Disconnected Drop Code

Select No.MWI confirmation Tone

Select TypeII_CPID.CPID Type

Enter 5000.Initial Wait for Inband CPID

Enter 500.Inband CPID Complete Timeout

Failover Settings

Select No.Enable Failover

Step 37 Select Submit.
Step 38 On the Configuration menu, select TDM > General.
Step 39 On the TDM General Settings page, enter the following settings.
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Table 31: TDM General Settings Page Settings

SettingsField

Select uLaw.PCM Coding

Enter 500.Minimum Call Party Delay (ms)

Enter 2000.Maximum Call Party Delay (ms)

Enter 100.Dial Digit on Time (ms)

Enter 100.Dial Inter-Digit Time (ms)

Enter 2000.Dial Pause Time (ms)

Enter the code that the phone system uses to turn MWIs
on.

Turn MWI On FAC

Enter the code that the phone system uses to turn MWIs
off.

Turn MWI Off FAC

Enter 10000.Outbound Call Connect Timeout (ms)

Select Yes.Wait for Ringback/Connect on Blind Transfer

Enter the pilot number of the Unity Connection voice
messaging ports.

Hunt Group Extension

Step 40 Select Submit.
Step 41 On the Configuration menu, select TDM > Port Enable.
Step 42 On the TDM Port Enabling page, select No for the ports that you want to disable on the TIMG unit.
Step 43 Confirm that Yes is selected for all other ports on the TIMG unit.
Step 44 Select Submit.
Step 45 On the Configuration menu, select VoIP > General.
Step 46 On the VoIP General Settings page, enter the following settings.

Table 32: VoIP General Settings Page Settings

SettingField

User-Agent

Enter the domain name of the TIMG unit.Host and Domain Name

Select UDP.Transport Type

Select No.Call as Domain Name

Select No.SIPS URI Scheme Enabled

Enter 120.Invite Expiration (sec)
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SettingField

Server

Enter the IP Address of the Domain Name Server that the
TIMG unit use.

DNS Server Address

Leave this field blank.Registration Server Address

Enter 5060.Registration Server Port

Enter 3600.Registration Expiration (sec)

TCP/UDP

Select Yes.UDP/TCP Transports Enabled

Enter 5060.TCP/UDP Server Port

Proxy

Leave this field blank.Primary Proxy Server Address

Not applicable. Leave the default setting.Primary Proxy Server Port

Not applicable. Leave the default setting.Backup Proxy Server Address

Not applicable. Leave the default setting.Backup Proxy Server Port

Enter 10.Proxy Query Interval

Timing

Enter 500.T1 Time

Enter 4000.T2 Time

Enter 5000.T4 Time

Monitoring

Select No.Monitor Call Connections

Step 47 Select Submit.
Step 48 On the Configuration menu, select VoIP > Media.
Step 49 On the VoIP Media Settings page, enter the following settings.

Table 33: VoIP Media Settings Page Settings

SettingsField

Audio
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SettingsField

Select the preferred codec for audio compression:

• G.711u—The TIMGunit uses only the G.711mu-law
codec.

• G.729AB—The TIMG unit prefers the G.729 codec
but can also use the G.711 mu-law codec.

Audio Compression

Select RFC2833.RTP Digit Relay Mode

Select Off.Signaling Digit Relay Mode

Select On.Voice Activity Detection

Select the applicable setting:

• G.711—20

• G.729AB—10

Failure to use the correct setting results in
recorded messages containing nothing but
silence.

Caution

Frame Size

Select the applicable setting:

• G.711—1

• G.729AB—2

Failure to use the correct setting results in
recorded messages containing nothing but
silence.

Caution

Frames Per Packet

Step 50 Select Submit.
Step 51 On the Configuration menu, select VoIP > QOS.
Step 52 On the VoIP QOS Configuration page, enter the following settings.

Table 34: VoIP QOS Configurative Page Settings

SettingsField

Enter 104 (equivalent to DSCP AF31).Call Control QOS Byte

Enter 184 (equivalent to DSCP EF).RTP QOS Byte

Step 53 Select Submit.
Step 54 On the Configuration menu, select IP.
Step 55 On the IP Settings, LAN1 page, enter the following settings.
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Table 35: IP Settings, LAN1 Page Settings

SettingsField

Enter the new IP address that you want to use for the TIMG
unit.

(This is the IP address that you enter in Cisco Unity
Connection Administration when you create the
integration.)

Client IP Address

Enter the new subnet mask, if the subnet mask is different
from the default IP address.

Client Subnet Mask

Enter the IP address of the default network gateway router
that the TIMG units use.

Default Network Gateway Address

If you are using DHCP, select Yes.

If you are not using DHCP, select No.

BOOTP Enabled

Step 56 Select Submit.
Step 57 On the Configuration menu, select Tone Detection.
Step 58 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn Tone Event field, select Busy and do the

following substeps to verify that the tone is correct.
a) From a available phone, call a second phone.
b) Answer the second phone when it rings, and leave both handsets off so that both phones are busy.
c) From a third phone, dial one of the busy phones.
d) Confirm that you hear a busy tone.
e) Hang up the third phone but leave the handsets for the other two phones off.

Step 59 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 58c. from the
third phone.

Step 60 Select Learn.
Step 61 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, select Error and do the following

substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does not exist.
b) Confirm that you hear the reorder or error tone.
c) Hang up the phone.

Step 62 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 61a.
Step 63 Select Learn.
Step 64 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, selectRingback and do the following

substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does exist.
b) Confirm that you hear the ringback tone.
c) Hang up the phone.

Step 65 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 64a.
Step 66 Select Learn.
Step 67 Select Submit.
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Step 68 Hang up the phones that you used in Step 58.
Step 69 On the Configuration menu, select Import/Export.
Step 70 On the Import/Export page, under Export Files, select Export All Settings.
Step 71 In the File Download dialog box, select Save.
Step 72 In the Save As dialog box, browse to theWindows workstation that has access to the TIMG units, browse to a directory

where you want to save the file, and select Save.
Step 73 In the Download Complete dialog box, select Open. Notepad opens the file Config.ini that you saved.
Step 74 Locate the line with the following parameter:

telautoanswer

Step 75 Confirm that the value of the parameter is no so that the line reads as follows:

telautoanswer = no

Step 76 Locate the line with the following parameter:

telFacCDropProc

Step 77 Confirm that the value of the parameter is !! so that the line reads as follows:

telFacCDropProc = !!

The telFacCDropProc parameter must be set to !!. If the telFacCDropProc parameter is set to 1, supervised
transfers fail, and the caller hears the called party standard greeting two times.

Caution

Step 78 Save the file, and exit Notepad.
Step 79 On the Configuration menu of the TIMG unit, select Import/Export.
Step 80 On the Import/Export page, under Browse for Import File, select Browse.
Step 81 In the Choose File dialog box, browse to the file Config.ini that you saved.
Step 82 Select Config.ini, and select Open.
Step 83 On the Import/Export page, select Import File.
Step 84 When prompted to restart the TIMG unit, select OK.
Step 85 Repeat Step 2 through Step 84 on all remaining TIMG units.

Creating an Integration with the Phone System
After ensuring that the phone system, the TIMG units, and the Unity Connection server are ready for the
integration, do the following procedures to set up the integration and to enter the port settings.

Step 1 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 2 On the Search Phone Systems page, under Display Name, select the name of the default phone system.
Step 3 On the Phone System Basics page, in the Phone System Name field, enter the descriptive name that you want for the

phone system.
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Step 4 If you want to use this phone system as the default for TRaP connections so that administrators and users without
voicemail boxes can record and playback through the phone in Unity Connection web applications, check the Default
TRAP Switch check box. If you want to use another phone system as the default for TRaP connections, uncheck this
check box.

Step 5 Select Save.
Step 6 On the Phone System Basics page, in the Related Links drop-down box, select Add Port Group and select Go.
Step 7 On the New Port Group page, enter the applicable settings and select Save.

Table 36: Settings for the New Port Group Page

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG in the drop-down box.

Create From

Enter a descriptive name for the port group. You can accept
the default name or enter the name that you want.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the TIMG unit that you are
integrating with Unity Connection.

IPv4 Address or Host Name

Do not enter a value in this field. IPv6 is not supported for
TIMG integrations.

IPv6 Address or Host Name

Enter the IP address of the TIMG unit that you are
integrating with Unity Connection.

IP Address or Host Name

Enter the SIP port of the TIMG unit that Unity Connection
connects to. We recommend that you use the default
setting.

This name must match the setting in the
TCP/UDP Server Port field on the
Configuration > VoIP > General page of the
TIMG unit. Otherwise, the integration do not
function correctly.

Caution

Port

Step 8 On the Port Group Basics page, in the Related Links drop-down box, select Add Ports and select Go.
Step 9 On the New Port page, enter the following settings and select Save.

Table 37: Settings for the New Ports Page

ConsiderationsField

Check this check box.Enabled
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ConsiderationsField

Enter the number of voice messaging ports that you want
to create in this port group.

For a Unity Connection cluster, the server must
have the number of voice messaging ports that
are set up on the phone system for the TIMG
integration so that this server can handle all
voice messaging traffic for the cluster if one of
the servers stops functioning. For example, if
the phone system is set up with 16 voice
messaging ports, this server must have 16 voice
messaging ports.

Note

Number of Ports

Select the name of the phone system that you entered in
Step 3.

Phone System

Select the name of the port group that you added in Step 7.Port Group

Step 10 On the Search Ports page, select the display name of the first voice messaging port that you created for this phone
system integration.

By default, the display names for the voice messaging ports are composed of the port group display name
followed by incrementing numbers.

Note

Step 11 On the Port Basics page, set the voice messaging port settings as applicable. The fields in the following table are the
ones that you can change.

Table 38: Settings for the Voice Messaging Ports

ConsiderationsField

Check this check box to enable the port. The port is enabled
during normal operation.

Uncheck this check box to disable the port. When the port
is disabled, calls to the port get a ringing tone but are not
answered. Typically, the port is disabled only by the
installer during testing.

Enabled

Enter the extension for the port as assigned on the phone
system.

Extension

Check this check box to designate the port for answering
calls. These calls can be incoming calls from unidentified
callers or from users.

Answer Calls

Check this check box to designate the port for notifying
users of messages. Assign Perform Message Notification
to the least busy ports.

Perform Message Notification
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ConsiderationsField

Check this check box to designate the port for turning
MWIs on and off. Assign Send MWI Requests to the least
busy ports.

Send MWI Requests

Check this check box so that users can use the port for
recording and playback through the phone in Unity
Connection web applications. Assign Allow TRAP
Connections to the least busy ports.

Allow TRAP Connections

Enter the priority order in which Unity Connection uses
the ports when dialing out (for example, if the Perform
Message Notification, Send MWI Requests, or Allow
TRAP Connections check box is checked). The highest
numbers are used first. However, whenmultiple ports have
the same Outgoing Hunt Order number, Unity Connection
uses the port that has been idle the longest.

Outgoing Hunt Order

Step 12 Select Save.
Step 13 Select Next.
Step 14 Repeat Step 11 through Step 13 for all remaining voice messaging ports for the phone system.
Step 15 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 16 On the Search Phone Systems page, under Display Name, select the name of the phone system that you entered in

Step 3.
Step 17 Repeat Step 6 through Step 16 for each remaining TIMG unit integrated with Unity Connection.

Each TIMG unit is connected to one port group with the applicable voice messaging ports. For example, a
system that uses two TIMG units requires two port groups, one port group for each TIMG unit.

Note

Step 18 If another phone system integration exists, in Cisco Unity Connection Administration, expandTelephony Integrations,
then select Trunk. Otherwise, skip to Step 22.

Step 19 On the Search Phone System Trunks page, on the Phone System Trunk menu, select New Phone System Trunk.
Step 20 On the New Phone System Trunk page, enter the following settings for the phone system trunk and select Save.

Table 39: Settings for the Phone System Trunk

SettingField

Enter the display name of the phone system that you are
creating a trunk for.

From Phone System

Enter the display name of the previously existing phone
system that the trunk connects to.

To Phone System

Enter the extra digits that Unity Connection must dial to
transfer calls through the gateway to extensions on the
previously existing phone system.

Trunk Access Code

Step 21 Repeat Step 19 and Step 20 for all remaining phone system trunks that you want to create.
Step 22 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Port Group.

TIMG Integration Guide for Cisco Unity Connection Release 14
44

Setting Up an Avaya S8500/S8700 In-Band TIMG Integration with Cisco Unity Connection
Creating an Integration with the Phone System



Step 23 On the Search Port Groups page, select the display name of the port group that you added in Step 7.
Step 24 On the Port Group Basics page, select Reset.
Step 25 When prompted that resetting terminates all call traffic, select OK.
Step 26 In the Related Links drop-down list, select Check Telephony Configuration and select Go to confirm the phone

system integration settings.
If the test is not successful, the Task Execution Results displays one or more messages with troubleshooting steps. After
correcting the problems, test the connection again.

Step 27 In the Task Execution Results window, select Close.
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C H A P T E R 5
Setting Up a Serial (SMDI, MCI, or MD-110) TIMG
Integration with Cisco Unity Connection

For detailed instructions for setting up a serial (SMDI, MCI, or MD-110) TIMG integration with Cisco Unity
Connection, see the following sections in this chapter:

• Task List to Create a Serial (SMDI, MCI, or MD-110) TIMG, on page 47
• Requirements, on page 48
• Programming Phone System for a Serial TIMG Integration, on page 49
• Setting Up the TIMG Units, on page 50
• Creating an Integration with the Phone System, on page 61

Task List to Create a Serial (SMDI, MCI, or MD-110) TIMG
Before doing the following tasks to integrate Unity Connection with the phone system using the T1 media
gateway (TIMG), confirm that the Unity Connection server is ready for the integration after completing the
installation following the steps as mentioned in the "Installing Cisco Unity Connection" chapter of the Install,
Upgrade, and Maintenance Guide for Cisco Unity Connection, Release 12.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/install_upgrade/guide/b_12xcuciumg.html

1. Review the system and equipment requirements to confirm that all phone system and Unity Connection
server requirements have been met. See the Requirements section.

2. Plan how the voice messaging ports are used by Unity Connection. See the Planning the Usage of Voice
Messaging Ports in Cisco Unity Connection chapter.

3. Program the phone system and extensions. See the Programming Phone System for a Serial TIMG
Integration section.

4. Set up the TIMG units. See the Setting Up the TIMG Units scetion.

5. Create the integration. See the Creating an Integration with the Phone System section.

6. Test the integration. See the Testing the Integration chapter.

7. If this integration is a second or subsequent integration, add the applicable new user templates for the new
phone system. See the Adding New User Templates for Multiple Integrations chapter.
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Requirements
The serial (SMDI, MCI, or MD-110) TIMG integration supports configurations of the following components:

Phone System
• A phone system that supports the SMDI, MCI, or MD-110 serial protocols.

• T1 digital trunk interface card.
• The firmware must be configured to support T1 line-side signaling.

• T1 CAS connections to the TIMG units using the FXS/FSO or E&M protocol.

• One or more TIMG units (media gateways).

• The serial data port on the phone system connected to the serial port on the master TIMG unit with an
RS-232 serial cable (which is available from Cisco).

Specifications for the serial cable are in Connecting PBX-IP Media Gateway (PIMG) to the Serial Port of a
PBX at http://www.dialogic.com/support/helpweb/mg/tn117.htm.

We recommend that the serial cable have the following construction:

• A maximum of 50 feet (15.24 m) in length

• 24 AWG stranded conductors

• Low capacitance—for example, no more than 12 pF/ft (39.4 pF/m) between conductors

• At least 65 percent braided shield over aluminized polymer sleeve around conductors

• UL-recognized overall cable jacket insulation with low dielectric constant

• Braided shield fully terminated to and enclosed by a metal connector backshell

• Gold-plated connector contacts

• The voice messaging ports in the phone system connected by T1 digital lines (DS1 or “dry T1” digital
lines only) to the ports on the TIMG units.

T1 (or “wet T1”) connections to the PSTN must be through an MTU, CSU, or
other device that provides line isolation. Otherwise, the TIMG units may be
damaged.

Caution

• The TIMG units connected to the same LAN or WAN that Unity Connection is connected to.

• If the TIMG units connect to a WAN, the requirements for the WAN network connections are:

• For G.729a codec formatting, a minimum of 32.76 Kbps guaranteed bandwidth for each voice
messaging port.

• For G.711 codec formatting, a minimum of 91.56 Kbps guaranteed bandwidth for each voice
messaging port.
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• No network devices that implement network address translation (NAT).

• A maximum 200 ms one-way network latency.

• The phone system ready for the integration, as described in the documentation for the phone system.

Unity Connection Server
• Unity Connection installed and ready for the integration after completing the installation following the
steps as mentioned in the Installing Cisco Unity Connection chapter of the Install, Upgrade, and
Maintenance Guide for Cisco Unity Connection, Release 11.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/11x/install_upgrade/guide/b_11xcuciumg.html

• A license that enables the applicable number of voice messaging ports.

Centralized Voice Messaging
Unity Connection supports centralized voice messaging through the phone system, which supports various
inter-phone system networking protocols including proprietary protocols such as Avaya DCS, Nortel MCDN,
or Siemens CorNet, and standards-based protocols such as QSIG or DPNSS. Note that centralized voice
messaging is a function of the phone system and its inter-phone system networking, not voicemail. Unity
Connection supports centralized voice messaging as long as the phone system and its inter-phone system
networking are properly configured.

Programming Phone System for a Serial TIMG Integration
If you use programming options other than those supplied in the following procedure, the performance of the
integration may be affected.

In programming the phone system, do not send calls to voice messaging ports in Unity Connection that cannot
answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging port
is set only to Perform Message Notification, do not send calls to it.

Caution

Instruct the phone system technician to set up the phone system in the manner as directed in the following
procedure.

Programming the Phone System for a Serial Integration with Unity Connection

Step 1 Program the analog lines connecting to the voice messaging ports on the TIMG units as a multiline hunt group.

Make sure that the phone system sends calls only to Unity Connection voice ports that are set to Answer Calls. Calls sent
to a voice port not set to Answer Calls cannot be answered by Unity Connection and may cause other problems.

Step 2 Enable hookflash transfer capability on each analog line that connects to the voice messaging ports on the TIMG units.
Step 3 Enable caller ID (via SMDI, MCI, or MD-110) on each subscriber extension.
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Step 4 For each subscriber extension, set the call forwarding options to the following:

• Unrestricted source
• Forward when the extension is not answered
• Forward when the extension is busy

Setting Up the TIMG Units
Do the following procedures to set up the analog TIMG units (media gateways) that are connected to the
phone system.

These procedures require that the following tasks have already been completed:

• The phone system is connected to the TIMG units using T1 digital lines and the applicable RS-232 serial
cable.

• The TIMG units are connected to a power source.

• The TIMG units are ready to be connected to the LAN or WAN.

Because TIMG units have the same default IP address, you must set them up one
at a time. Otherwise, you can experience IP address conflicts.

Caution

Fields that are not mentioned in the following procedures must keep their default values. For the default values
of all fields, see the manufacturer documentation for the TIMG units.

Downloading TIMG Firmware Update Files for TIMG Units

SUMMARY STEPS

1. On a Windows workstation that have access to the TIMG units, go to the following link:
http://software.cisco.com/download/navigator.html?mdfid=280082558&i=rm.

2. In the tree control on the Downloads Home page, expand Unified Communications> Unified
Communications Applications > Messaging > Cisco Unity and select Cisco Unity Telephony
Integration.

3. On the Log In page, enter your username and password, then select Log In.
4. On the Select a Release page, under Latest Releases, select the most recent release.
5. In the right column, select the version of the firmware for your TIMG units.
6. On the Download Image page, select Download.
7. On the Supporting Document(s) page, select Agree.
8. In the File Download dialog box, select Save.
9. In the Save As dialog box, browse to theWindows workstation that have access the TIMG units, browse

to a directory where you want to save the file, and select Save.
10. In the Download Complete dialog box, select Open. The window for extracting the TIMG firmware

update files appears.
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11. Select Extract.
12. In the Extract dialog box, browse to the directory where you want the extracted files, and selectExtract.
13. Close the window for the extracting application.

DETAILED STEPS

Step 1 On a Windows workstation that have access to the TIMG units, go to the following link:
http://software.cisco.com/download/navigator.html?mdfid=280082558&i=rm.

To access the software download page, you must be signed in to Cisco.com as a registered user.

This procedure describes the steps when using Internet Explorer as your web browser. If you are using a
different web browser, the steps may differ.

Note

Step 2 In the tree control on the Downloads Home page, expand Unified Communications> Unified Communications
Applications > Messaging > Cisco Unity and select Cisco Unity Telephony Integration.

Step 3 On the Log In page, enter your username and password, then select Log In.
Step 4 On the Select a Release page, under Latest Releases, select the most recent release.
Step 5 In the right column, select the version of the firmware for your TIMG units.
Step 6 On the Download Image page, select Download.
Step 7 On the Supporting Document(s) page, select Agree.
Step 8 In the File Download dialog box, select Save.
Step 9 In the Save As dialog box, browse to the Windows workstation that have access the TIMG units, browse to a directory

where you want to save the file, and select Save.
Step 10 In the Download Complete dialog box, selectOpen. The window for extracting the TIMG firmware update files appears.
Step 11 Select Extract.
Step 12 In the Extract dialog box, browse to the directory where you want the extracted files, and select Extract.
Step 13 Close the window for the extracting application.

Setting Up the TIMG Units (Firmware Version 6.x)

Step 1 On the Windows workstation, add a temporary route to enable access to the TIMG units.
a) On the Windows Start menu, select Run.
b) Enter cmd, and press Enter. The Command Prompt window appears.
c) At the command prompt, enter route add 10.12.13.74 <IP Address of Workstation>, and press Enter.

For example, if the IP address of the workstation is 198.1.3.25, enter “route add 10.12.13.74<space>198.1.3.25”
in the Command Prompt window.

d) Close the Command Prompt window.

Step 2 Connect a TIMG unit to the network.
Step 3 In the web browser, go to http://10.12.13.74.
Step 4 To sign in, enter the following case-sensitive settings.
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Table 40: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

Step 5 Select OK.
Step 6 On the System menu, select Upgrade.
Step 7 On the Upgrade page, under Browse for Upgrade File, select Browse.
Step 8 In the Choose File dialog box, browse to the directory on theWindows workstation that has the extracted TIMG firmware

update files.
Step 9 Select T1E1_<xx > .app (where <xx> is multiple digits), and select Open.
Step 10 On the Upgrade page, select Install File.
Step 11 After the file is installed, a message prompting you to restart the TIMG unit appears. Select Cancel.

Do not restart the TIMG unit until you are instructed to do so later in this procedure, even if the file installation
fails. Restarting the TIMG unit at this step may prevent the TIMG unit from functioning correctly.

Caution

Step 12 Repeat Step 6 through Step 11 for the file T1E1_<xx>.fsh.
Step 13 On the System menu, select Upgrade.
Step 14 On the Upgrade page, under Browse for Upgrade File, select Browse.
Step 15 In the Choose File dialog box, browse to the file T1E1_<xx>.msd.
Step 16 Select T1E1_<xx > .msd, and select Open.
Step 17 On the Upgrade page, click Install File.
Step 18 After the file is installed, a message prompting you to restart the TIMG unit appears. Select OK.
Step 19 In the web browser, go to http://10.12.13.74.
Step 20 To sign in, enter the following case-sensitive settings.

Table 41: Sign-in Settings

SettingField

Enter admin.Username

Enter IpodAdmin.Password

Step 21 Select OK.
Step 22 On the Configure menu, select Password.
Step 23 On the Change Password page, enter the following settings.

Table 42: Change Password Page Settings

SettingField

Enter IpodAdmin. (This setting is case sensitive.)Old Password

Enter your new password. (This setting is case sensitive.)New Password
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SettingField

Enter your new password. (This setting is case sensitive.)Confirm Password

Step 24 Select Change.
Step 25 On the Configuration menu, select Mgmt Protocols.
Step 26 On the Management Protocols page, enter the following settings.

Table 43: Management Protocols Page Settings

SettingsField

Select No.E-mail Alarms Enabled

Select No.SNMP Traps Enabled

Select Yes.HTTP Server Enabled

Select No.HTTPs Server Enabled

Step 27 Select Submit.
Step 28 On the Configuration menu, select Routing Table.
Step 29 On the Routing Table page, under Router Configuration, select VoIP Host Groups.
Step 30 Under VoIP Host Groups, enter the following settings for the first VoIP Host Group.

Table 44: First VoIP Host Group Settings

SettingsField

Accept the default or enter another descriptive name of
the VoIP host group.

Name

(Unity Connection without a cluster) Select False.

(Unity Connection with a cluster configured) Select False.

Load-Balanced

(Unity Connection without a cluster) Select False.

(Unity Connection with a cluster configured) Select True.

Fault-Tolerant

Step 31 For Unity Connection without a cluster, under Host List, enter the host name or IP address of the Unity Connection
server and the server port in the format <host name or IP address>:5060.

For Unity Connection with a cluster configured, under Host List, enter the host name or IP address of the subscriber
server (the second Unity Connection server that you installed) and the server port in the format <host name or IP
address>:5060.

Step 32 For Unity Connection without a cluster, continue to Step 34. For Unity Connection with a cluster configured, select
Add Host.

Step 33 In the second field, enter the host name or IP address of the publisher server (the first Unity Connection server that you
installed) and the server port in the format <host name or IP address>:5060.
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Do not add a third host under Host List or a second host group under VoIP Host Groups. Otherwise, the Unity
Connection cluster may not function correctly.

Caution

Step 34 Select Submit.
Step 35 On the Configuration menu, select TDM > T1/E1.
Step 36 On the T1/E1 Configuration page, enter the following settings.

Table 45: T1/E1 Configuration Page Settings

SettingsField

Line Settings

Select T1.Line Mode

Select CAS.Signaling Mode

Select Terminal.Interface Mode

T1 Line

Enter the setting that matches the phone system
programming.

Line Encoding

Enter the setting that matches the phone system
programming.

Framing

Enter the setting that matches the phone system
programming.

Selects Transmit Pulse Waveform

T1 CAS Protocol

Enter the setting that matches the phone system
programming.

T1 CAS Protocol

Enter the setting that matches the phone system
programming.

Flash Hook

Enter the setting that matches the phone system
programming.

Consult Call Dialtone Drop Code

Enter the setting that matches the phone system
programming.

Consult Call Proceeding Drop Code

Enter the setting that matches the phone system
programming.

Consult Call Busy Drop Code

Enter the setting that matches the phone system
programming.

Consult Call Error Drop Code

Enter the setting that matches the phone system
programming.

Consult Call Connected Drop Code

Enter the setting that matches the phone system
programming.

Consult Call Disconnected Drop Code
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SettingsField

Select No.MWI confirmation Tone

Select TypeII_CPID.CPID Type

Enter 100.Initial Wait for Inband CPID

Enter 300.Inband CPID Complete Timeout

Failover Settings

Select No.Enable Failover

Step 37 Select Submit.
Step 38 On the Configuration menu, select TDM > General.
Step 39 On the TDM General Settings page, enter the following settings.

Table 46: TDM General Settings Page Settings

SettingsField

Select uLaw.PCM Coding

Enter 500.Minimum Call Party Delay (ms)

Enter 2000.Maximum Call Party Delay (ms)

Enter 100.Dial Digit on Time (ms)

Enter 100.Dial Inter-Digit Time (ms)

Enter 2000.Dial Pause Time (ms)

Leave this field blank.Turn MWI On FAC

Leave this field blank.Turn MWI Off FAC

Enter 10000.Outbound Call Connect Timeout (ms)

Select Yes.Wait for Ringback/Connect on Blind Transfer

Enter the pilot number of the Unity Connection voice
messaging ports.

Hunt Group Extension

Step 40 Select Submit.
Step 41 On the Configuration menu, select TDM > Port Enable.
Step 42 On the TDM Port Enabling page, select No for the ports that you want to disable on the TIMG unit.
Step 43 Confirm that Yes is selected for all other ports on the TIMG unit.
Step 44 Select Submit.
Step 45 On the Configuration menu, select VoIP > General.
Step 46 On the VoIP General Settings page, enter the following settings.
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Table 47: VoIP General Settings Page Settings

SettingField

User-Agent

Enter the domain name of the TIMG unit.Host and Domain Name

Select UDP.Transport Type

Select No.Call as Domain Name

Select No.SIPS URI Scheme Enabled

Enter 120.Invite Expiration (sec)

Server

Enter the IP Address of the Domain Name Server that the
TIMG unit uses.

DNS Server Address

Leave this field blank.Registration Server Address

Enter 5060.Registration Server Port

Enter 3600.Registration Expiration (sec)

TCP/UDP

Select Yes.UDP/TCP Transports Enabled

Enter 5060.TCP/UDP Server Port

Proxy

Leave this field blank.Primary Proxy Server Address

Not applicable. Leave the default setting.Primary Proxy Server Port

Not applicable. Leave the default setting.Backup Proxy Server Address

Not applicable. Leave the default setting.Backup Proxy Server Port

Enter 10.Proxy Query Interval

Timing

Enter 500.T1 Time

Enter 4000.T2 Time

Enter 5000.T4 Time

Monitoring

Select No.Monitor Call Connections
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Step 47 Select Submit.
Step 48 On the Configuration menu, select VoIP > Media.
Step 49 On the VoIP Media Settings page, enter the following settings.

Table 48: VoIP Media Settings Page Settings

SettingsField

Audio

Select the preferred codec for audio compression:

• G.711u—The TIMGunit uses only the G.711mu-law
codec.

• G.729AB—The TIMG unit prefers the G.729 codec
but can also use the G.711 mu-law codec.

Audio Compression

Select RFC2833.RTP Digit Relay Mode

Select Off.Signaling Digit Relay Mode

Select On.Voice Activity Detection

Select the applicable setting:

• G.711—20

• G.729AB—10

Failure to use the correct setting results in
recorded messages containing nothing but
silence.

Caution

Frame Size

Select the applicable setting:

• G.711—1

• G.729AB—2

Failure to use the correct setting results in
recorded messages containing nothing but
silence.

Caution

Frames Per Packet

Step 50 Select Submit.
Step 51 On the Configuration menu, select VoIP > QOS.
Step 52 On the VoIP QOS Configuration page, enter the following settings.

Table 49: VoIP QOS Configurative Page Settings

SettingsField

Enter 104 (equivalent to DSCP AF31).Call Control QOS Byte
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SettingsField

Enter 184 (equivalent to DSCP EF).RTP QOS Byte

Step 53 Select Submit.
Step 54 On the Configuration menu, select Serial > General.
Step 55 On the Serial Port, COM 1 page, enter the following settings.

Table 50: Serial Port, COM 1 Page Settings

SettingsField

Select the setting that is configured on the phone system.

The default setting is 9600.

Serial Port Baud Rate

Select the setting that is configured on the phone system.

The default setting is None.

Serial Port Parity

Select the setting that is configured on the phone system.

The default setting is 8.

Serial Port Data Bits

Select the setting that is configured on the phone system.

The default setting is 1.

Serial Port Stop Bits

Step 56 Select Submit.
Step 57 On the Configuration menu, select Serial > Switch Protocol.
Step 58 On the Switch Protocol page, enter the following settings.

Table 51: Switch Protocol Page Settings

SettingsField

Serial Port, COM 1

Select the applicable setting:

• Master—Select this setting when this TIMG unit is
connected to the data link serial cable from the phone
system. There can be only one master TIMG unit in
a phone system integration.

• Slave—Select this setting when this TIMG unit is not
connected to the data link serial cable from the phone
system. There can be multiple slave TIMG units in a
phone system integration.

Serial Mode (Master/Slave)
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SettingsField

Select the serial protocol that your phone system uses:

• SMDI

• MCI

• MD110

Serial Interface Protocol

(For MCI protocol only) Select the applicable number of
extension digits.

MCI Message Extension Length

(For MCI protocol only) Select the applicable message
type.

MCI Message Type

Select the applicable setting. Typically, the settings are 7
or 10.

Cpid Length

Enter the applicable string or leave this field blank.
Typically, the setting is one of the following:

• A string of zeros, where the number of zeros matches
the setting of the Cpid Len field.

• A prefix that is provided by the Centrex service.

Cpid Padding String

If the setting of the Serial Interface Protocol field is
MD-110, enter 2. Otherwise, accept the default of 7.

Voice Mail Port Length

Enter the applicable setting. Typically, the setting is 1.System Number

Enter 2000.MWI Response Timeout (ms)

If the TIMG unit is the master, leave this field blank.

If the TIMG unit is a slave, enter the IP address of the
master TIMG unit (the TIMG unit that is connected to the
data link serial cable from the phone system).

IP Address of Serial Server

Enter 5000.Serial Cpid Expiration (ms)

Logical Extension Number

If the setting of the Serial Interface Protocol field is MCI
or MD-110, enter the extension number for each port on
the TIMG unit.

If the setting of the Serial Interface Protocol field is SMDI,
enter the logical port number. Typically, the setting is 1
for port 1, 2 for port 2, and so on beginning with the master
TIMG unit and continuing through each of the slave TIMG
units.

<port number>

Step 59 Select Submit.
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Step 60 On the Configuration menu, select IP.
Step 61 On the IP Settings, LAN1 page, enter the following settings.

Table 52: IP Settings, LAN1 Page Settings

SettingsField

Enter the new IP address that you want to use for the TIMG
unit.

(This is the IP address that you enter in Cisco Unity
Connection Administration when you create the
integration.)

Client IP Address

Enter the new subnet mask, if the subnet mask is different
from the default IP address.

Client Subnet Mask

Enter the IP address of the default network gateway router
that the TIMG units use.

Default Network Gateway Address

If you are using DHCP, select Yes.

If you are not using DHCP, select No.

BOOTP Enabled

Step 62 Select Submit.
Step 63 On the Configuration menu, select Tone Detection.
Step 64 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn Tone Event field, select Busy and do the

following substeps to verify that the tone is correct.
a) From a available phone, call a second phone.
b) Answer the second phone when it rings, and leave both handsets off so that both phones are busy.
c) From a third phone, dial one of the busy phones.
d) Confirm that you hear a busy tone.
e) Hang up the third phone but leave the handsets for the other two phones off.

Step 65 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 64c. from the
third phone.

Step 66 Select Learn.
Step 67 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, select Error and do the following

substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does not exist.
b) Confirm that you hear the reorder or error tone.
c) Hang up the phone.

Step 68 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 67a.
Step 69 Select Learn.
Step 70 On the Tone Detection page, under Call Progress Tone - Learn, in the Learn field, selectRingback and do the following

substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does exist.
b) Confirm that you hear the ringback tone.
c) Hang up the phone.

TIMG Integration Guide for Cisco Unity Connection Release 14
60

Setting Up a Serial (SMDI, MCI, or MD-110) TIMG Integration with Cisco Unity Connection
Setting Up the TIMG Units (Firmware Version 6.x)



Step 71 Under Call Progress Tone - Learn, in the Dial String field, enter the extension that you dialed in Step 70a.
Step 72 Select Learn.
Step 73 Select Submit.
Step 74 Hang up the phones that you used in Step 64.
Step 75 On the System menu, select Restart.
Step 76 On the Restart page, select Restart Unit Now.
Step 77 Repeat Step 2 through Step 76 on all remaining TIMG units.

Creating an Integration with the Phone System
After ensuring that the phone system, the TIMG units, and the Unity Connection server are ready for the
integration, do the following procedures to set up the integration and to enter the port settings.

Step 1 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 2 On the Search Phone Systems page, under Display Name, select the name of the default phone system.
Step 3 On the Phone System Basics page, in the Phone System Name field, enter the descriptive name that you want for the

phone system.
Step 4 If you want to use this phone system as the default for TRaP connections so that administrators and users without

voicemail boxes can record and playback through the phone in Unity Connection web applications, check the Default
TRAP Switch check box. If you want to use another phone system as the default for TRaP connections, uncheck this
check box.

Step 5 Select Save.
Step 6 On the Phone System Basics page, in the Related Links drop-down box, select Add Port Group and select Go.
Step 7 On the New Port Group page, enter the applicable settings and select Save.

Table 53: Settings for the New Port Group Page

SettingField

Select the name of the phone system that you entered in
Step 3.

Phone System

Select Port Group Template and select SIP to
DMG/PIMG/TIMG in the drop-down box.

Create From

Enter a descriptive name for the port group. You can accept
the default name or enter the name that you want.

Display Name

Select 5060.SIP Security Profile

Select the SIP transport protocol that Unity Connection
uses.

SIP Transport Protocol

Enter the IP address of the TIMG unit that you are
integrating with Unity Connection.

IPv4 Address or Host Name
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SettingField

Do not enter a value in this field. IPv6 is not supported for
TIMG integrations.

IPv6 Address or Host Name

Enter the IP address of the TIMG unit that you are
integrating with Unity Connection.

IP Address or Host Name

Enter the SIP port of the TIMG unit that Unity Connection
connects to. We recommend that you use the default
setting.

This name must match the setting in the
TCP/UDP Server Port field on the
Configuration > VoIP > General page of the
TIMG unit. Otherwise, the integration do not
function correctly.

Caution

Port

Step 8 In the Related Links drop-down box, select Add Ports and select Go.
Step 9 On the New Port page, enter the following settings and select Save.

Table 54: Settings for the New Port Page

ConsiderationsField

Check this check box.Enabled

Enter the number of voice messaging ports that you want
to create in this port group.

For a Unity Connection cluster, the server must
have the number of voice messaging ports that
are set up on the phone system for the TIMG
integration so that this server can handle all
voice messaging traffic for the cluster if one of
the servers stops functioning. For example, if
the phone system is set up with 16 voice
messaging ports, this server must have 16 voice
messaging ports.

Note

Number of Ports

Select the name of the phone system that you entered in
Step 3.

Phone System

Select the name of the port group that you added in Step 7.Port Group

Step 10 On the Search Ports page, select the display name of the first voice messaging port that you created for this phone
system integration.

By default, the display names for the voice messaging ports are composed of the port group display name
followed by incrementing numbers.

Note

Step 11 On the Port Basics page, set the voice messaging port settings as applicable. The fields in the following table are the
ones that you can change.
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Table 55: Settings for the Voice Messaging Ports

ConsiderationsField

Check this check box to enable the port. The port is enabled
during normal operation.

Uncheck this check box to disable the port. When the port
is disabled, calls to the port get a ringing tone but are not
answered. Typically, the port is disabled only by the
installer during testing.

Enabled

Enter the extension for the port as assigned on the phone
system.

Extension

Check this check box to designate the port for answering
calls. These calls can be incoming calls from unidentified
callers or from users.

Answer Calls

Check this check box to designate the port for notifying
users of messages. Assign Perform Message Notification
to the least busy ports.

Perform Message Notification

Uncheck this check box. Otherwise, the integration may
not function correctly.

Send MWI Requests

Check this check box so that users can use the port for
recording and playback through the phone in Unity
Connection web applications. Assign Allow TRAP
Connections to the least busy ports.

Allow TRAP Connections

Enter the priority order in which Unity Connection uses
the ports when dialing out (for example, if the Perform
Message Notification, Send MWI Requests, or Allow
TRAP Connections check box is checked). The highest
numbers are used first. However, whenmultiple ports have
the same Outgoing Hunt Order number, Unity Connection
uses the port that has been idle the longest.

Outgoing Hunt Order

Step 12 Select Save.
Step 13 Select Next.
Step 14 Repeat Step 11 through Step 13 for all remaining voice messaging ports for the phone system.
Step 15 In Cisco Unity Connection Administration, expand Telephony Integrations, then select Phone System.
Step 16 On the Search Phone Systems page, under Display Name, select the name of the phone system that you entered in

Step 3.
Step 17 Repeat Step 6 through Step 16 for each remaining TIMG unit integrated with Unity Connection.

Each TIMG unit is connected to one port group with the applicable voice messaging ports. For example, a
system that uses two TIMG units requires two port groups, one port group for each TIMG unit.

Note

Step 18 If another phone system integration exists, in Cisco Unity Connection Administration, expandTelephony Integrations,
then select Trunk. Otherwise, skip to Step 22.
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Step 19 On the Search Phone System Trunks page, on the Phone System Trunk menu, select New Phone System Trunk.
Step 20 On the New Phone System Trunk page, enter the following settings for the phone system trunk and select Save.

Table 56: Settings for the Phone System Trunk

SettingField

Enter the display name of the phone system that you are
creating a trunk for.

From Phone System

Enter the display name of the previously existing phone
system that the trunk connects to.

To Phone System

Enter the extra digits that Unity Connection must dial to
transfer calls through the gateway to extensions on the
previously existing phone system.

Trunk Access Code

Step 21 Repeat Step 19 and Step 20 for all remaining phone system trunks that you want to create.
Step 22 In the Related Links drop-down list, select Check Telephony Configuration and select Go to confirm the phone

system integration settings.

If the test is not successful, the Task Execution Results displays one or more messages with troubleshooting steps. After
correcting the problems, test the connection again.

Step 23 In the Task Execution Results window, select Close.
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C H A P T E R 6
Testing the Integration

To test whether Cisco Unity Connection and the phone system are integrated correctly, do the following
procedures in the order listed.

If any of the steps indicate a failure, see the following documentation as applicable:

• The installation guide for the phone system.
• Troubleshooting Guide for Cisco Unity Connection, Release 11.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/11x/troubleshooting/guide/b_11xcuctsg.html.

• The setup information earlier in this guide.

• Testing the Integration, on page 65

Testing the Integration
To test whether Cisco Unity Connection and the phone system are integrated correctly, do the following
procedures in the order listed.

If any of the steps indicate a failure, see the following documentation as applicable:

• The installation guide for the phone system.
• Troubleshooting Guide for Cisco Unity Connection, Release 11.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/11x/troubleshooting/guide/b_11xcuctsg.html.

• The setup information earlier in this guide.

Setting Up Test Configuration

Step 1 Set up two test extensions (Phone 1 and Phone 2) on the same phone system that Unity Connection is connected to.
Step 2 Set Phone 1 to forward calls to the Unity Connection pilot number when calls are not answered.

The phone system must forward calls to the Unity Connection pilot number in no fewer than four rings.
Otherwise, the test may fail.

Caution

Step 3 In Cisco Unity Connection Administration, expand Users, then select Users.
Step 4 On the Search Users page, select the display name of a user to use for testing. The extension for this user must be the

extension for Phone 1.
Step 5 On the Edit User Basics page, uncheck the Set for Self-enrollment at Next Login check box.
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Step 6 In the Voice Name field, record a recorded name for the test user.
Step 7 Select Save.
Step 8 On the Edit menu, select Message Waiting Indicators.
Step 9 On the Message Waiting Indicators page, select the message waiting indicator. If no message waiting indication is in

the table, select Add New.
Step 10 On the Edit Message Waiting Indicator page, enter the following settings.

Table 57: Settings for the Edit MWI Page

SettingField

Check this check box to enable MWIs for the test user.Enabled

Accept the default or enter a different name.Display Name

Check this check box to enable MWIs on Phone 1.Inherit User’s Extension

Step 11 Select Save.
Step 12 On the Edit menu, select Transfer Rules.
Step 13 On the Transfer Rules page, select the active option.
Step 14 On the Edit Transfer Rule page, under Transfer Action, select the Extension option and enter the extension of Phone 1.
Step 15 In the Transfer Type field, select Release to Switch.
Step 16 Select Save.
Step 17 Minimize the Cisco Unity Connection Administration window. Do not close the Cisco Unity Connection Administration

window because you use it again in a later procedure.
Step 18 Sign in to the Cisco Unified Real-Time Monitoring Tool (RTMT).
Step 19 On the Cisco Unity Connection menu, select Port Monitor. The Port Monitor tool appears in the right pane.
Step 20 In the right pane, select Start Polling. The Port Monitor displays which port is handling the calls that you make.

Testing an External Call with Release Transfer

Step 1 From Phone 2, enter the access code necessary to get an outside line, then enter the number outside callers use to dial
directly to Unity Connection.

Step 2 In the Port Monitor, note which port handles this call.
Step 3 When you hear the opening greeting, enter the extension for Phone 1. Hearing the opening greeting means that the port

is configured correctly.
Step 4 Confirm that Phone 1 rings and that you hear a ringback tone on Phone 2. Hearing a ringback tone means that Unity

Connection correctly released the call and transferred it to Phone 1.
Step 5 Leaving Phone 1 unanswered, confirm that the state of the port handling the call changes to “Idle.” This state means

that release transfer is successful.
Step 6 Confirm that, after the number of rings that the phone system is set to wait, the call is forwarded to Unity Connection

and that you hear the greeting for the test user. Hearing the greeting means that the phone system forwarded the
unanswered call and the call-forward information to Unity Connection, which correctly interpreted the information.
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Step 7 On the Port Monitor, note which port handles this call.
Step 8 Leave a message for the test user and hang up Phone 2.
Step 9 In the Port Monitor, confirm that the state of the port handling the call changes to “Idle.” This state means that the port

was successfully released when the call ended.
Step 10 Confirm that the MWI on Phone 1 is activated. The activated MWI means that the phone system and Unity Connection

are successfully integrated for turning on MWIs.

Testing Listening to the Messages

Step 1 From Phone 1, enter the internal pilot number for Unity Connection.
Step 2 When asked for your password, enter the password for the test user. Hearing the request for your password means that

the phone system sent the necessary call information to Unity Connection, which correctly interpreted the information.
Step 3 Confirm that you hear the recorded name for the test user (if you did not record a name for the test user, you hear the

extension number for Phone 1). Hearing the recorded name means that Unity Connection correctly identified the user by
the extension.

Step 4 Listen to the message.
Step 5 After listening to the message, delete the message.
Step 6 Confirm that theMWI on Phone 1 is deactivated. The deactivatedMWImeans that the phone system andUnity Connection

are successfully integrated for turning off MWIs.
Step 7 Hang up Phone 1.
Step 8 On the Port Monitor, confirm that the state of the port handling the call changes to “Idle.” This state means that the port

was successfully released when the call ended.

Setting Up Supervised Transfer

Step 1 In Cisco Unity Connection Administration, on the Edit Transfer Rule page for the test user, in the Transfer Type field,
select Supervise Transfer.

Step 2 In the Rings to Wait For field, enter 3 and select Save.
Step 3 Minimize the Cisco Unity Connection Administration window. Do not close the Cisco Unity Connection Administration

window because you use it again in a later procedure.

Testing Supervised Transfer

Step 1 From Phone 2, enter the access code necessary to get an outside line, then enter the number outside callers use to dial
directly to Unity Connection.

Step 2 On the Port Monitor, note which port handles this call.
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Step 3 When you hear the opening greeting, enter the extension for Phone 1. Hearing the opening greeting means that the port
is configured correctly.

Step 4 Confirm that Phone 1 rings and that you do not hear a ringback tone on Phone 2. Instead, you should hear the indication
your phone system uses to mean that the call is on hold (for example, music).

Step 5 Leaving Phone 1 unanswered, confirm that the state of the port handling the call remains “Busy.” This state and hearing
an indication that you are on hold mean that Unity Connection is supervising the transfer.

Step 6 Confirm that, after three rings, you hear the greeting for the test user. Hearing the greeting means that Unity Connection
successfully recalled the supervised-transfer call.

Step 7 During the greeting, hang up Phone 2.
Step 8 On the Port Monitor, confirm that the state of the port handling the call changes to “Idle.” This state means that the

port was successfully released when the call ended.
Step 9 Select Stop Polling.
Step 10 Exit RTMT.

Deleting the Test User
If any of the above steps indicate failure, see the following documentation as applicable:

• The installation guide for the phone system.

• Troubleshooting Guide for Cisco Unity Connection, Release 11.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/11x/troubleshooting/guide/b_11xcuctsg.html

Step 1 In Cisco Unity Connection Administration, expand Users, then select Users.
Step 2 On the Search Users page, check the check box to the left of the test user.
Step 3 Select Delete Selected.
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C H A P T E R 7
Adding New User Templates for Multiple
Integrations

• Adding New User Templates for Multiple Integrations, on page 69

Adding New User Templates for Multiple Integrations

Introduction
When you create the first phone system integration, this first phone system is automatically selected in the
default user template. The users that you add after creating this phone system integration assigned to this
phone system by default.

However, for each additional phone system integration that you create, you must add the applicable new user
templates that are assigned to users of the new phone system. You must add the new templates before you
add new users assigned to the new phone system.

For details on adding new user templates, or on selecting a user template when adding a new user, see the
“User Templates” section of the “User Attributes” chapter of the SystemAdministration Guide for Cisco Unity
Connection, Release 11.x, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/11x/administration/guide/b_cucsag.html.
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C H A P T E R 8
Application Note for the Intecom Pointspan 6880
TIMG Integration

• Introduction, on page 71
• Network Topology, on page 71
• Requirements, on page 72
• Programming Intecom Pointspan 6880 Phone System for TIMG Integration, on page 72
• Configuring the RS-232 Serial Cable, on page 74

Introduction
This is an application note for programming the Intecom Pointspan 6880 phone system for a serial SMDI
integration with Cisco Unity Connection using TIMG units. For instructions on setting up the TIMG units
(media gateways) and creating the integration in Unity Connection, see the Setting Up an Avaya Definity G3
In-Band TIMG Integration with Cisco Unity Connection chapter.

Network Topology
Figure 8-1 shows the required Cisco Unity Connection Administration for a serial SMDI integration using
TIMG units.

Figure 3: Connections for a Serial SMDI TIMG Integration

For more information about this integration, see Integration Description chapter.
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Requirements
The phone system met the following requirements:

• The Intecom Pointspan 6880 phone system.

• Software version 3.4K or later.

• PDI cards model 520-1000-004.

• T1 cards model 300-0289-001.

Programming Intecom Pointspan 6880 Phone System for TIMG
Integration

The following programming instructions are provided as an example. The specific programming for your
phone system may vary depending on its configuration.

In programming the phone system, do not send calls to voice messaging ports in Unity Connection that cannot
answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging port
is set only to Perform Message Notification, do not send calls to it.

Caution

Example of Programming for the Intecom Pointspan 6880 Phone System in a TIMG Integration

** TRUNK GROUP DEFINITION
***...TRUNK GROUP........................17
***...TRUNK GROUP TYPE...................UNIVERSAL
TCI...TRUNK CLASS IDENTIFICATION.........LOCAL CO
UGP...USER GROUP NUMBER..................11
VTT...VOICE TRUNK TRANSFER ENABLED.......YES
CDT...TRANSFER COLLECT DIGIT TABLE #.....NONE
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DCS...DEFAULT CLASS OF SERVICE...........0
CNC...NATIONAL CALLING PARTY # CONTENTS..USER GROUP
CNI...USER GROUP CALLING PARTY #.........4 = 206-555-1212
DCP...DISPLAY CALLING PARTY NUMBER.......YES
PND...PRIVATE NETWORK....................NO
ITY...INTEMAIL TYPE......................INTEMAIL TYPE II
IST...DOES InteMail SUPERVISE TRANSFERS?.NO
IML...InteMail USER ID LENGTH............5
IIN...INTEMAIL INTERFACE NUMBER..........2
VNP...InteMail NUMBER FORMAT.............DIRN
OAM...OAI ASSOCIATED MEMBER..............NO
BTG...BROADCAST TRUNK GROUP..............NO
TCM...TRAVELING CLASSMARK................NO
FTH...FAILURE THRESHOLD..................3
RDT...RESEIZE DELAY TIME............MSEC:200
CHT...TRUNK MONITOR MINIMUM HOLD TIME....0
DET...DISTANT END RELEASE TIME.......SEC:55
DCT...DATA CALLS ALLOWED.................NO
SWM...SEIZE WHEN MOS.....................NO
TCH...TRUNK CALL HANDLING................INTERNAL
NDS...DISCONNECT SUPERVISION.............YES
IGG...IGNORE GLARE.......................NO
GDT...GLARE DETECT TIME.............MSEC:100
XFT...DISTANT IBX ALLOWS FEATURE TRANSP..NO
DPT...DTMF PASSTHROUGH TIMING INDEX......NONE
......TRUNK DIRECTION....................BOTH WAYS
*** INCOMING PARAMETERS
STY...INCOMING CALL ORIGINATION TYPE.....T1 OFF PREM.....OPX (OFF PREMISE)
TYP...INCOMING TRUNK TYPE................DIALED
ICM...INCOMING CALL MESSAGE #............17
IDS...INCOMING DIGIT SEQUENCE............DESTINATION NUMBER ONLY
IRD...RESPONSE TO DESTINATION NUMBER.....NONE
IRC...RESPONSE TO CALLING PARTY NUMBER...NONE
IIT...INCOMING INFO DIGIT TYPE/LENGTH....NONE
WPR...WHISPER MESSAGE SOURCE GROUP.......NONE
APA...TRUNK GROUP AUTHORIZATION TYPE.....NONE
PVA...PRE-VALIDATE AUTHORIZATION CODE....NO
RSC...RESET COUNT........................1
LVL...PREDEFINED LEVEL CODE..............NONE
TNE...TONE TABLE ENTRY NUMBER............NONE
MOD...INCOMING DIAL MODE.................DTMF
RGF...DTMF RECEIVER GROUP................52
TOO...TIMEOUT TO ATTENDANT...............NO
MCL...MULTIPLE CALLING ALLOWED...........NO
RAC...REUSE AUTH FOR MULT. CALLS.........NO
GAC...GROUP AUTH REQUIRED FOR TRUNKS.....NO
SAC...SYSTEM ACCESS CODE.................NONE
CWR...CALLWAIT RINGBACK..................NO
UCT...TRUNK UPDATE CDR ON TRANSFER.......ALL
CPT...CALL PROGRESSING TONES:............IBX PROVIDED
RIO...RESPONSE TO INCOMING ORIGINATION...NONE
IUG...InteMail LAMP MESSAGE USER GROUPS..ALL
NUG...INTER-USER GROUP NNP USER GROUPS...ALL
TCT...STATION CALL RESTRICTION ENABLED...NO
8NC...800 TO 4D SPEED NUMBER CONVERSION..NO
NWT...CALL PARTY NAME WAIT TIME..........NONE
*** OUTGOING PARAMETERS
MSG...MODEM SIGNALLING...................YES
TXA...DIRECT TGRP SELECT ALLOWED.........YES
ATG...ANNOUNCEMENT TRUNK GROUP...........NO
SLC...TRUNK SELECTION....................TOP DOWN
ICA...INTER-LATA CARRIER.................10XXX
OPS...OUTGOING OUTPULSING SEQUENCE.......DESTINATION NUMBER ONLY
DIAGNOSTIC PARAMETERS: Y or N...............N
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Configuring the RS-232 Serial Cable
This integration followed the pinout below to configure the RS-232 serial cable using an RJ-45-to-DB-9
terminal adaptor connector.

Table 58: Pinout for the RS-232 Serial Cable

Serial Port Pin Definition from the Phone SystemDB-9 Pin

DCD (data carrier detect)1

RX (transmit)2

TX (receive)3

DTR (data terminal ready)4

GND (signal ground)5

DSR (data set ready)6

RTS (request to send)7

CTS (clear to send)8

(no Unity Connection)9
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C H A P T E R 9
Application Note for the NEC NEAX 2400 IMX
TIMG Integration

• Introduction, on page 75
• Network Topology, on page 75
• Requirements, on page 76
• Programming NEC NEAX 2400 IMX Phone System for TIMG Integration, on page 76

Introduction
This is an application note for programming the NEC NEAX 2400 IMX phone system for a serial SMDI
integration with Cisco Unity Connection using TIMG units. For instructions on setting up the TIMG units
(media gateways) and creating the integration in Unity Connection, see the Setting Up a Serial (SMDI, MCI,
or MD-110) TIMG Integration with Cisco Unity Connection chapter.

Network Topology
Network Topology shows the required connections for a serial SMDI integration using TIMG units.
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Figure 4: Connections for a Serial SMDI TIMG Integration

For more information about this integration, see Integration Description

Requirements
The phone system met the following requirements:

• The NEC NEAX 2400 IMX phone system.

• MCI feature II.

• One T1 digital trunk interface card (card number PA-24DTR/DLI) for each group of 24 voice messaging
ports.

Note that the following requirements for the T1 digital trunk interface card before programming the phone
system:

• The firmware must be configured to support T1 line-side signaling.

• The card must be validated.

Programming NEC NEAX 2400 IMX Phone System for TIMG
Integration

The following programming instructions are provided as an example. The specific programming for your
phone system may vary depending on its configuration.

In programming the phone system, do not send calls to voice messaging ports in Unity Connection that cannot
answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging port
is set only to Perform Message Notification, do not send calls to it.

Caution
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Example of Programming for the NEC NEAX 2400 IMX Phone System in a TIMG Integration

1. Use the AUCD command to program the phone system to send UCD call information to MCI. Assign a
value of “0” to the “MCI Data Transfer” field for the applicable tenant and UCD pilot numbers.

2. Use the programming system data table to program the ASYD settings. Each bit is part of a hexadecimal
number displayed in the ASYD settings. Convert the hexadecimal number to binary to determine the
individual settings.
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Table 59: Programming System Data

DescriptionValueBitIndexSystem

Release (blind)
transfer to attendant
console

1b4171

Guard timer not
required

0b0–428

MWI controlled by
MCI

1b5

No/Yes: Assign I/O
port forMCI output

Port 1 = b1, port 2
= b2, and so on

0/1b1–729

Set output to no
parity and 1 stop bit

0b1–434

UCD queuing
required

0b360

Release transfer for
stations in service

1b063

No recall, execute
call forwarding on
no answer

1b069

Called number
display, when
forwarding to
attendant console

1b070

Calling number
display enabled

1b078

Called station status
display enabled

1b1

Lamp flash rate0b0–7238

MCI expansion set
to normal

0b3246

Calling number
information sent to
MCI

1b2400
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DescriptionValueBitIndexSystem

MCI in service
when terminating to
a UCD group

1b062

MCI out of service
when terminating to
attendant console

0b17

3. Use the programming system data local data table to program the ASYDL settings. Each bit is part of a
hexadecimal number displayed in the ASYDL settings. Convert the hexadecimal number to binary to
determine the individual settings.

Table 60: Programming System Data Local Data

DescriptionValueBitIndexSystem

0/1: MCI/IMX
station
number/phone
number

0/1b16411

Assign the FPC of
the node connected
to MC

00–FDb0–7832

MWI controlled by
MCI

0b0833

4. Use the ASDT command to add ports that connect to the first voice messaging port on the first TIMG
unit by entering the following settings.

Table 61: ASDT Command Settings for Adding Ports

SettingField

Enter the tenant number, which is typically 1.TN

Enter the station number.STN

Enter 11 (which sets the port type as “voice mail”).
Some sites may require setting this to 3 in order to
complete transfers to Virtual Line Groups (AMNO).

TEC

Accept the default (all route options) or enter
another route service class.

RSC

Accept the default (all options) or enter another
service feature class.

SFC

5. In the WRT field, enter Y and press Enter.
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6. Repeat Step 4. and Step 5. for all remaining ports that connect to the voice messaging ports on the TIMG
unit.

7. Repeat Step 6. for all remaining TIMG units.

8. Use the ASHU command to add the UCD hunt group access number (a real or virtual extension number)
by entering the following settings.

Table 62: ASHU Command Settings for Adding the Hunt Group Access Number

SettingField

Enter the tenant number, which is typically 1.TN

Enter the access number. for the hunt group.STN

Enter the extensions for each voice messaging port
on the TIMG units, pressing Enter after each
extension.

Edit STN

9. Select Set.
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C H A P T E R 10
Application Note for the Nortel SL-100 TIMG
Integration

• Introduction, on page 81
• Network Topology, on page 81
• Requirements, on page 82
• Programming Nortel SL-100 Phone System for TIMG Integration, on page 82
• Configuring the RS-232 Serial Cable, on page 92

Introduction
This is an application note for programming the Nortel SL-100 phone system for a serial SMDI integration
with CiscoUnity Connection using TIMGunits. For instructions on setting up the TIMGunits (media gateways)
and creating the integration in Unity Connection, see the Setting Up a Serial (SMDI, MCI, or MD-110) TIMG
Integration with Cisco Unity Connection chapter.

Network Topology
Figure 10-1 shows the required connections for a serial SMDI integration using TIMG units.

Figure 5: Connections for a Serial SMDI TIMG Integration

For more information about this integration, see the Integration Description chapter.
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Requirements
The phone system met the following requirements:

• The Nortel SL-100 phone system.

• Software version SE-06 or later.

• Line Side T1 Card (NT5D11 or equivalent) to terminate the T1 line.

Programming Nortel SL-100 Phone System for TIMG Integration
The following programming instructions are provided as an example. The specific programming for your
phone system may vary depending on its configuration.

In programming the phone system, do not send calls to voice messaging ports in Unity Connection that cannot
answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging port
is set only to Perform Message Notification, do not send calls to it.

Caution

Example of Programming for the Nortel SL-100 Phone System in a TIMG Integration

1. On the MAP terminal, enter table mpc and press Enter.

2. Enter add and press Enter.

3. On Table MPC, enter the following settings.
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Table 63: Settings for Table MPC

SettingField

Enter the MPC number used for SMDI.MPCNO

Enter the number associated with the MPC (SMDI)
card.

MPCIOC

Enter the slot position on the IOC shelf multiplied by
4, from 0 to 32.

IOCCCT

Enter the NT product engineering code for the MPC
card in the format 1X89zz or FX30zz, where zz are
the two letters at the end of the product code.

EQ

In the format MPCAxxyy, enter the name of the
8-character download file for SMDI and MPCA.

DLDFILE

1. Enter table mpclink and press Enter.

2. Enter add and press Enter.

3. On Table MPCLINK, enter the following settings.

Table 64: Settings for Table MPCLINK

SettingSubfieldField

Enter the MPC number used for
SMDI (the same number entered in
Table MPC).

MPCNOLINKKEY

Enter the MPC link number for
SMDI application with ASYNC
protocol.

LINKNO

Enter Y to activate the MPCLINK
alarm for system busy (SYSB)
MPC links. Enter N if you do not
want to activate the MPCLINK
alarm for system busy (SYSB)
MPC links.

If you enter N, the
system does not
generateMPC908 (MPC
link state transition)
logs.

Note

LINKALM

Enter ASYNC.PROTOCOL

Enter 765.LINKNABL

Enter APLDEFN.PARM
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SettingSubfieldField

Enter SMDI.ADEFN

Enter BAUDRATE.PARM

Enter B9600.RATE

Enter PARITY.PARM

Enter EVEN.PRTY

The following are among the
optional parameters: L1IDLY,
L2IDLY, LNKDOWN. If you enter
a parameter, you are then prompted
to enter a value for it.

L1IDLY and L2IDLY timers can
be used in offices with heavy
SMDI/VMS traffic to shorten the
amount of time the MPC can delay
sending anMWI to the switch. (The
default is 3 seconds.)

The LNKDOWN timer adjusts the
length of time the switch takes to
recognize LINK failure and sets the
LINK to SYSB. (The default is 2
seconds.)

PARM

Enter BIT7.CHARBITS

1. Enter table sllnkdev and press Enter.

2. Enter add and press Enter.

3. On Table SLLNKDEV, enter the following settings.

Table 65: Settings for Table SLLNKDEV

SettingField

Enter a unique device name.DEVNAME

Enter 1X89.DEVICE

Enter the value MPC number that was specified in
Table MPC.

MPCNO

Enter the value for the MPC link number that was
specified in Table MPCLINK.

LINKNO

Enter NONE.XLATION

TIMG Integration Guide for Cisco Unity Connection Release 14
84

Application Note for the Nortel SL-100 TIMG Integration
Programming Nortel SL-100 Phone System for TIMG Integration



SettingField

Enter NONE.PROTOCOL

Enter INOUTLK.DIRECTION

Enter SMDIDATA.XFER

Enter NUMOFDIGS.OPTION

The number of digits sent by the phone system to the
voice messaging system through the SMDI link.

The entry value selected should match the
dialing plan configured on the phone
system.

Note

NUMDIGS

Enter CGNADDRDN.OPTION

Enter $.OPTION

1. Enter table ofrt and press Enter.

You use Table OFRT to set up a treatment for unanswered calls. The following example shows
settings for routing unanswered calls back to the voice messaging system.

1. Enter add and press Enter.

2. On Table OFRT, enter the following settings.

Table 66: Settings for Table OFRT

SettingField

If the record is the first in the route list, enter the route
reference number assigned to the route list. Otherwise,
leave this field blank.

RTE

Enter the route selector.RTESEL

Enter the serving NPA (area code) of the DN.SNPA

Enter the type of call:

• DD

• NP

• OA

TYPCALL

Enter LCL (for local) or NLCL (for non-local).ORIGSCRE

Enter up to 11 replace digits.REPLDIGS

Enter Y or N to indicate whether to cancel normal
change.

CANCNORC
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SettingField

Enter the billing code. If there is no billing number,
enter N.

BILLCODE

1. Enter table digcol and press Enter.

You use Table DIGCOL to set up the action that the line module must take with the first digit that
is dialed.

1. Enter add and press Enter.

2. On Table DIGCOL, enter the following settings.

Table 67: Settings for Table DIGCOL

SettingSubfieldField

Enter the character assigned to the
block of data in Table DIGCOL.

DATNAMEDGKEY

Enter a numeric value from 0–9,
STAR (*), or OCT (#) to specify
the digit that is applicable to the
record.

DIGIT

Enter COL for the collection of
more digits.

DGCOLSELDGDATA

Enter S for short timing mode.TMODECOLDATA

Number of digits. If the TMODE
value is S, specify the number of
digits for which short timing is
required after the receipt of each
digit. The number of digits
specified, which does not include
the initial digit, must be no greater
than three for short timing.

NUMDIGS

1. Enter table ucdgroup and press Enter.

You use Table UCDGRP to set up the UCD group.

The UCD group must have a unique primary DN.

1. Enter add and press Enter.

2. On Table UCDGRP, enter the following settings.

Note
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Table 68: Settings for Table UCDGRP

SettingField

This is the name of the UCD group. It can be up to
16 characters in length. The first eight characters must
be unique.

UCDNAME

Enter N.ACD

Name of the customer group to which the UCD group
belongs.

CUSTGRP

Ringing threshold, in one-second intervals, after which
an unanswered call to a UCD agent is forwarded to
the route specified in the THROUT field. The range
is 0–63.

UCDRNGTH

Enter OFRT.TABNAME

Enter the number assigned to the route list in Table
OFRT (1–1023).

INDEX

Enter OFRT for the table to which translations are
routed.

TABNAME

Enter the number assigned to the route list in Table
OFRT (1–1023).

INDEX

Enter Maximum time, in seconds, a call can wait in
a UCD group (0–255).

PRIOPRO

Enter the maximum number of UCD agent positions
that can be active at one time. This number should be
the number of ports on the all TIMG units that are
connected to the phone system.

MAXPOS

Delayed billing. EnterY if billing starts when the call
is answered by a UCD agent. Enter N if billing starts
when the caller receives a recorded announcement.

DBG

Enter 0.DEFPRIO

Enter 0.RLSCNT

Enter the maximum time, in seconds, that a call waits
in the incoming call queue before being answered
(0–1800).

MAXWAIT

Enter the maximum number of calls that can be in the
incoming queue waiting for an idle channel (0–511).

MAXCQSIZ

Enter UCD_SMDI.OPTION
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SettingField

Enter the terminal designation defined in Table
SLLNKDEV.

SMDI_LINK

Enter the message desk number (1–63). If you have
more than one UCD group, one of them must be set
to 63. The first UCD group on a data link should be
set to 63. The second is set to 62, and so on.

If CRR (Call Request Retrieval) is used,
all requests are made to the UCD group
with SMDI_DSK_NO = 63.

Note

SMDI_ DESK_NO

1. Enter table dnroute and press Enter.

You use Table DNROUTE to set up the UCD group.

The UCD group must have a unique primary DN.

1. Enter add and press Enter.

2. On Table DNROUTE, enter the following settings.

Note

Table 69: Settings for Table DNROUTE

SettingSubfieldField

Enter the DN for the UCD group
specified as the UCDGRP.

The UCD DNmust be a
dialable number from an
agent on the phone
system so that dialing
plans and translation
tables do not conflict.

Note

AREACODEDNNM

OFCCODE

STNCODE

Enter FEAT.DN_SEL

Enter UCD.FEATURE

Enter the value for the UCDNAME
field that is defined in Table
UCDGROUP.

UCDGRP

Enter PRIM.DNTYPE

Enter 0.TOLLPRIO

1. Enter table lninv and press Enter.
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You use Table LNINV to assign card slots on the line or remote line module.

1. Enter add and press Enter.

2. On Table LNINV, enter the following settings.

Table 70: Settings for Table LNINV

SettingField

Enter the line equipment number of the card slot.LEN

Enter 5d11ae.CARDCODE

Enter the name of the appropriate pad group that
appears in the PADDATA table.

PADGRP

Enter WORKING.STATUS

Enter Y.GND

Enter NL.BNV

Enter Y.MNO

Enter NIL.CARDTYPE

1. Enter servord and press Enter.

You can add agents to the UCD group by entering the following inputs at the prompts.

Table 71: Inputs for Adding Agents to the UCD Group

DescriptionInputPrompt

NEWSO:

When to invoke this service.
Pressing Enter starts the service at
the current date and time.

Press Enter.SONUMBER:

The Directory Number of the line.
Use ten-digit DNs.

DN:

The line class code of service.IBNLCC_ACC:

The name of the IBN customer
group to which the line belongs.
For example, covm.

GROUP:

The subgroup number. For
example, 0.

SUBGRP:

The network class of service. For
example, 1.

NCOS:
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DescriptionInputPrompt

The serving NPA (area code) of the
DN.

SNPA:

The line equipment number of the
line. For example, 4 0 1 0
(separated by spaces).

LEN_OR_LT D:

The cut-off on disconnect.CODOPTION:

Uniform call distribution.UCDOPTION:

Digitone.DGTOPTION:

Three-way calling.3WCOPTION:

Call Transfer.CXROPTION:

Call Transfer Type. CTALL =
transfer all calls.

CTALLCXFERTYP:

Call Transfer Recall.NCXRRCL:

Method of Call Transfer: Std = Std
Call Transfer method.

STDMETHOD:

Simplified message desk interface.SMDIOPTION:

The UCD terminal number. This is
the line number associated with the
SMDI channel. This parameter
must be unique for each agent in
the associated UCDGRP.

LINENO:

The UCDNAME from the
UCDGRP table. This is the UCD
group to which you are adding the
agent.

UCDGRP:

Autologon capability required.YAUTO_LOG:

The data you have entered appears.$OPTION:

Enter Y.Y

1. Enter servord and press Enter.

You can add a pilot number (UCD group DN) for the ports on the TIMG units by entering the
following inputs at the prompts.
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Table 72: Inputs for Adding Agents to the UCD Group

DescriptionInputPrompt

NEWSO:

When to invoke this service.
Pressing Enter starts the service at
the current date and time.

Press Enter.SONUMBER:

The directory number of the line.
This is the DN that you enter in the
SDN table.

DN:

The line class code of service.IBNLCC:

The name of the IBN customer
group to which the line belongs.

GROUP:

The subgroup number.SUBGRP:

The network class of service.NCOS:

Serving NPA (area code) of the
DN.

SNPA:

Line equipment number of the line.
For example, 4 0 1 0.

LEN:

Call Forward Busy.

This input is optional.Note

cfbOPTION:

Normal assignment for CFB.

This input is optional.Note

NCFBCNTL:

The primary UCD DN.

This input is optional.Note

CFBDN:

Call Forward Fixed.CFFOPTION:

The Primary UCD DN.CFFDN:

Call Forward Universal.CFUOPTION:

Override Automatic Callback.NOVRDACR:

The data you entered appears.$OPTION:

Enter Y to confirm the data.Y

1. Connect a phone to the line.

2. Pick up the handset.
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3. Dial the call forward activation code followed by the pilot number (UCD DN). For example,
dial *80 5551234.

If you do not know this code, look it up in Table IBNXLA. The code is in the CFWP field.Note

4. Confirm that you hear the confirmation tone, which indicates that the line has been forwarded.

If the phone system is restarted, you must repeat Step 27. through Step 30. for each line DN that
CFUs to the UCD group.

Note

5. Enter table ibnxla and press Enter.

You use Table IBNXLA to set up and message waiting indicators (MWIs).

1. Enter add and press Enter.

2. On Table IBNXLA, enter the following settings.

Table 73: Settings for Table IBNXLA

SettingSubfieldField

Enter the name of the translator,
1–8 characters, for the MWI
feature.

XLANAMEKEY

Enter the access code for the MWI
feature.

DGLIDX

Enter FEAT.TRSELRESULT

Enter N.ACR

Enter N.SMDR

Enter the following features:

CRA CRR CRDS CRDA UCDD
UCDA CFWP CFWC

FEATURE

Configuring the RS-232 Serial Cable
This integration used a null modem cable. The pinout for a DB-9 terminal adaptor connector is below.
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Table 74: Pinout for a DB-9 Connector

Serial Port Pin Definition from the Phone SystemDB-9 Pin

Data Carrier Detect1

Transmit Data (required)2

Receive Data (required)3

Data Terminal Ready4

Signal Ground (required)5

Data Set Ready6

Clear to Send7

Request to Send8

Ring Indicator9

The pinout for a 34-pin to DB-25 terminal adaptor connector is below.

Table 75: Pinout for a 35-Pin to DB-25 Connector

Serial Port Pin Definition from the
Phone System

Pin for DB-25 ConnectorPin for 34-Pin Connector

Transmit Data (required)214

Receive Data (required)326

Request to Send (required)423

Clear to Send (required)534

Data Set Ready (required)616

Signal Ground (required)711

Data Carrier Detect (required)831

Data Terminal Ready (required)2037

Receive Clock1716

Secondary Data Carrier Detect1217

Secondary Clock Transmit External2424
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C H A P T E R 11
Settings for TIMG Firmware Version 5.x

• Introduction, on page 95
• TIMG Settings for a Serial Integration (Firmware Version 5.x), on page 95
• TIMG Settings for an In-Band Integration (Firmware Version 5.x), on page 103

Introduction
This chapter provide the information for TIMG settings when firmware version 5.x is installed on the TIMG
units. You must upgrade your TIMG units to the most recent version that is available at
http://software.cisco.com/download/navigator.html?mdfid=280082558&i=rm. For instructions on downloading
and installing the most recent TIMG firmware, see the chapter for your phone system integration in this guide.

TIMG Settings for a Serial Integration (Firmware Version 5.x)

Step 1 On a Windows workstation, sign in to a TIMG unit.
Step 2 On the Configure menu, select IP.
Step 3 On the IP page, enter the following settings for LAN1.

Table 76: IP Page Settings for LAN1

SettingField

Enter the new IP address that you want to use for the TIMG
unit.

(This is the IP address that you enter in UTIM when you
create the integration.)

Client IP Address

Enter the new subnet mask, if the subnet mask is different
from the default IP address.

Client Subnet Mask

Enter the IP address of the default network gateway router
that the TIMG units use.

Default Network Gateway Address
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SettingField

If you are using DHCP, select Yes.

If you are not using DHCP, select No.

BOOTP Enabled

Step 4 Select Apply Changes.
Step 5 On the Configure menu, select System.
Step 6 On the System page, enter the following settings.

Table 77: System Page Settings for the System and Telephony Groups

SettingField

Select SIP.Operating Mode

Select uLaw.PCM Coding

Step 7 Determine which serial port on the TIMG unit you use to connect the data link serial cable from the phone system, then
enter the following settings in the applicable group.

Table 78: System Page Settings for Serial Port Groups

SettingField

Select the setting that is configured on the phone system.

The default setting is 9600.

Serial Port Baud Rate

Select the setting that is configured on the phone system.

The default setting is None.

Serial Port Parity

Select the setting that is configured on the phone system.

The default setting is 8.

Serial Port Data Bits

Select the setting that is configured on the phone system.

The default setting is 1.

Serial Port Stop Bits

Step 8 Select Apply Changes.
Step 9 On the Configure menu, select Gateway.
Step 10 On the Gateway page, select the Gateway Routing tab.
Step 11 On the Gateway Routing tab, Unity Connection without a cluster, skip to Step 12. If Unity Connection has a cluster

configured, do the following substeps:
a) In the Fault Tolerance Enabled field, select Yes.
b) In the Load Balancing Enabled field, select No.

Step 12 Under VoIP Endpoint ID, enter the following settings.
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Table 79: Gateway Routing Tab Settings

SettingField

(Unity Connection without a cluster) Enter the server name
of the Unity Connection server.

(Unity Connection with a cluster configured) Enter the
server name of the subscriber server.

VoIP Endpoint ID: 1

(Unity Connection without a cluster) Enter the server name
of the Unity Connection server.

(Unity Connection with a cluster configured) Enter the
server name of the publisher server.

VoIP Endpoint ID: 2

Step 13 Select Apply Changes.
Step 14 On the Gateway page, select the Gateway Advanced tab.
Step 15 On the Gateway Advanced tab, enter the following settings.

Table 80: Gateway Advanced Tab Settings

SettingsField

Advanced Call Routing

Select OnAnswer.Call Connect Mode

Select No.Send DNIS to VoIP Endpoint

Leave this field blank.Destination for Unroutable IP Calls

Leave this field blank.Destination for Unroutable PBX Calls

Select No.Monitor Call Connections

Telephony

Enter 500.Minimum Call Party Delay

Enter 2000.Maximum Call Party Delay

Enter 100.Dial Digit on Time

Enter 100.Dial Inter-Digit Time

Enter 2000.Dial Pause Time

Leave this field blank.Turn MWI On FAC

Leave this field blank.Turn MWI Off FAC

Select None.Dial Send Key

Enter 10000.Outbound Call Connect Timeout
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SettingsField

Select Yes.Wait for Ringback/Connect on Blind Transfer

Enter the pilot number for the Unity Connection voice
messaging ports.

Hunt Group Extension

Audio

Select the preferred codec for audio compression:

• G.711

• G.729AB

Audio Compression

Select RFC2833.RTP Digit Relay Mode

Select Off.Signaling Digit Relay Mode

Select On.Voice Activity Detection

Select the applicable setting:

• G.711—20

• G.729AB—10

Failure to use the correct setting results in
recorded messages containing nothing but
silence.

Caution

Frame Size

Select the applicable setting:

• G.711—1

• G.729AB—2

Failure to use the correct setting results in
recorded messages containing nothing but
silence.

Caution

Frames Per Packet

Quality of Service

Enter 104 (equivalent to DSCP AF31).Call Control QOS Byte

Enter 184 (equivalent to DSCP EF).RTP QOS Byte

Traps and Alarms

Select No.E-mail Alarms Enabled

Select No.SNMP Traps Enabled

Select Yes.HTTP Server Enabled

Select No.HTTPs Server Enabled
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Step 16 Select Apply Changes.
Step 17 On the Gateway page, select the Gateway Capabilities tab.
Step 18 Enter the following settings for all ports that are used by voice messaging ports on Unity Connection.

Table 81: Gateway Capabilities Tab Settings

SettingField

Select Both.Telephony Port Capability

For ports that are used by voice messaging ports on Unity
Connection, select Yes.

For ports that are not used, select No.

Telephony Port Enabled

Step 19 Select Apply Changes.
Step 20 On the Configure menu, select T1E1.
Step 21 On the T1E1 page, select the T1/E1 Mode tab.
Step 22 On the T1/E1 Mode tab, enter the following settings.

Table 82: T1/E1 Mode Tab Settings

SettingField

Select T1.Line Mode

Select CAS.Signaling Mode

Select Terminal.Interface Mode

Step 23 Select Apply Changes.
Step 24 Select the T1-CAS Protocol tab.
Step 25 On the T1-CAS Protocol tab, enter the following settings.

Table 83: T1-CAS Protocol Tab Settings

SettingField

Enter the setting that matches the phone system
programming.

T1 CAS Protocol

Enter the setting that matches the phone system
programming.

Line Encoding

Enter the setting that matches the phone system
programming.

Framing

Enter the setting that matches the phone system
programming.

Selects Transmit Pulse Waveform

Enter the setting that matches the phone system
programming.

Flash Hook
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SettingField

Enter the setting that matches the phone system
programming.

Consult Call Dialtone Drop Code

Enter the setting that matches the phone system
programming.

Consult Call Proceeding Drop Code

Enter the setting that matches the phone system
programming.

Consult Call Busy Drop Code

Enter the setting that matches the phone system
programming.

Consult Call Error Drop Code

Enter the setting that matches the phone system
programming.

Consult Call Connected Drop Code

Enter the setting that matches the phone system
programming.

Consult Call Disconnected Drop Code

Select No.MWI confirmation Tone

Select TypeII_CPID.CPID Type

Enter 100.Initial Wait for Inband CPID

Enter 300.Inband CPID Complete Timeout

Step 26 Select Apply Changes.
Step 27 On the Configure menu, select Serial Protocol.
Step 28 On the Serial Protocol page, enter the following settings.

Table 84: Serial Protocol Page Settings

SettingField

Select the applicable setting:

• Master—Select this setting when this TIMG unit is
connected to the data link serial cable from the phone
system. There can be only one master TIMG unit in
a phone system integration.

• Slave—Select this setting when this TIMG unit is not
connected to the data link serial cable from the phone
system. There can be multiple slave TIMG units in a
phone system integration.

Serial Mode (Master/Slave)

Select the serial protocol that your phone system uses:

• SMDI

• MCI

• MD-110

Serial Interface Protocol
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SettingField

Enter 2000.MWI Response Timeout

If the TIMG unit is the master, leave this field blank.

If the TIMG unit is a slave, enter the IP address of the
master TIMG unit (the TIMG unit that is connected to the
data link serial cable from the phone system).

IP Address of Serial Server

Enter 5000.Serial Cpid Expiration

If the TIMG unit is the master, leave this field blank.

If the TIMG unit is a slave, enter the IP address of the
master TIMG unit (the TIMG unit that is connected to the
data link serial cable from the phone system).

Logical Extension Number

Step 29 Select Apply Changes.
Step 30 On the Configure menu, select SIP.
Step 31 On the SIP page, enter the following settings.

Table 85: SIP Page Settings

SettingField

Enter the domain name of the TIMG unit.Host and Domain Name

Select UDP.Transport Type

Select No.Call as Domain Name

Select No.SIPS URI Scheme Enabled

Enter 120.Invite Expiration

Enter the IP address of the DNS server.DNS Server Address

Leave this field blank.Registration Server Address

Enter 5060.Registration Server Port

Enter 3600.Registration Expiration

Select Yes.UDP/TCP Transports Enabled

Enter 5060.TCP/UDP Server Port

Leave this field blank.Primary Proxy Server Address

Not applicable. Leave the default setting.Primary Proxy Server Port

Not applicable. Leave the default setting.Backup Proxy Server Address

Not applicable. Leave the default setting.Backup Proxy Server Port
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SettingField

Enter 10.Proxy Query Interval

Enter 500.T1 Time

Enter 4000.T2 Time

Enter 5000.T4 Time

Step 32 Select Apply Changes.
Step 33 On the Configure menu, select Tones.
Step 34 On the Tones page, select the Learn tab.

Destination addresses cannot be duplicated in the same session. Otherwise, the process for learning tones do
not succeed. If you do not have enough available phones to learn all the tones at one time, you can run multiple
sessions to learn tones individually by checking or unchecking the applicable Acquire Tone check boxes.

Caution

Step 35 On the Tones page, for the Dialtone event, confirm that the Acquire Tone check box is checked and leave the Destination
Address field blank.

Step 36 On the Tones page, for the Busy Tone event, confirm that the Acquire Tone check box is checked and do the following
substeps to verify that the tone is correct.
a) From a available phone, call a second phone.
b) Answer the second phone when it rings, and leave both handsets off so that both phones are busy.
c) From a third phone, dial one of the busy phones.
d) Confirm that you hear a busy tone.
e) Hang up the third phone but leave the handsets for the other two phones off.

Step 37 On the Tones page, in the Destination Address field for Busy Tone, enter the extension that you dialed in Step 36c.
from the third phone.

Step 38 On the Tones page, for the Error/Reorder Tone event, confirm that the Acquire Tone check box is checked and do the
following substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does not exist.
b) Confirm that you hear the reorder or error tone.
c) Hang up the phone.

Step 39 On the Tones page, in the Destination Address field for Error/Reorder Tone, enter the extension that you dialed in
Step 38a.

Step 40 On the Tones page, for the Ringback Tone event, confirm that the Acquire Tone check box is checked and do the
following substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does exist.
b) Confirm that you hear the ringback tone.
c) Hang up the phone.

Step 41 On the Tones page, in the Destination Address field for Ringback Tone, enter the extension that you dialed in Step 40a.
Step 42 Select Learn.
Step 43 When the process is complete, check the check box for each newly learned tone and select Apply.
Step 44 Hang up the phones that you used in Step 36.
Step 45 If the TIMG unit is connected to a Nortel SL-100 phone system, do the following substeps to learn the stutter dial tone.

Otherwise, continue to Step 46.
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a) On the Tones page, on the Learn tab, for the Dialtone event, confirm that the Acquire Tone check box is checked
and enter ! in the Destination Address field.

b) Uncheck the Acquire Tone check boxes for all other tones.
c) Select Learn.
d) When the process is complete, check the check box for each newly learned tone and select Apply.

Step 46 On the Configure menu, select Restart.
Step 47 On the Restart page, select Restart Unit Now.
Step 48 When the TIMG unit has restarted, in the View menu, select Refresh.
Step 49 Repeat Step 1 through Step 48 on all remaining TIMG units.

TIMG Settings for an In-Band Integration (Firmware Version
5.x)

Step 1 On a Windows workstation, sign in to a TIMG unit.
Step 2 On the Configure menu, select IP.
Step 3 On the IP page, enter the following settings for LAN1.

Table 86: IP Page Settings for LAN1

SettingField

Enter the new IP address that you want to use for the TIMG
unit.

(This is the IP address that you enter in UTIM when you
create the integration.)

Client IP Address

Enter the new subnet mask, if the subnet mask is different
from the default IP address.

Client Subnet Mask

Enter the IP address of the default network gateway router
that the TIMG units use.

Default Network Gateway Address

If you are using DHCP, select Yes.

If you are not using DHCP, select No.

BOOTP Enabled

Step 4 Select Apply Changes.
Step 5 On the Configure menu, select System.
Step 6 On the System page, enter the following settings.
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Table 87: System Page Settings for the System and Telephony Groups

SettingField

Select SIP.Operating Mode

Select uLaw.PCM Coding

Step 7 Select Apply Changes.
Step 8 On the Configure menu, select Gateway.
Step 9 On the Gateway page, select the Gateway Routing tab.
Step 10 On the Gateway Routing tab, Unity Connection without a cluster, skip to Step 11. If Unity Connection has a cluster

configured, do the following substeps:
a) In the Fault Tolerance Enabled field, select Yes.
b) In the Load Balancing Enabled field, select No.

Step 11 Under VoIP Endpoint ID, enter the following settings.

Table 88: Gateway Routing Tab Settings

SettingField

(Unity Connection without a cluster) Enter the server name
of the Unity Connection server.

(Unity Connection with a cluster configured) Enter the
server name of the subscriber server.

VoIP Endpoint ID: 1

(Unity Connection without a cluster) Enter the server name
of the Unity Connection server.

(Unity Connection with a cluster configured) Enter the
server name of the publisher server.

VoIP Endpoint ID: 2

Step 12 Select Apply Changes.
Step 13 On the Gateway page, select the Gateway Advanced tab.
Step 14 On the Gateway Advanced tab, enter the following settings.

Table 89: Gateway Advanced Tab Settings

SettingsField

Advanced Call Routing

Select OnAnswer.Call Connect Mode

Select No.Send DNIS to VoIP Endpoint

Leave this field blank.Destination for Unroutable IP Calls

Leave this field blank.Destination for Unroutable PBX Calls

Select No.Monitor Call Connections
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SettingsField

Telephony

Enter 500.Minimum Call Party Delay

Enter 2000.Maximum Call Party Delay

Enter 100.Dial Digit on Time

Enter 100.Dial Inter-Digit Time

Enter 2000.Dial Pause Time

Enter the code that the phone system uses to turn MWIs
on.

Turn MWI On FAC

Enter the code that the phone system uses to turn MWIs
off.

Turn MWI Off FAC

Select None.Dial Send Key

Enter 10000.Outbound Call Connect Timeout

Select Yes.Wait for Ringback/Connect on Blind Transfer

Enter the pilot number for the Unity Connection voice
messaging ports.

Hunt Group Extension

Audio

Select the preferred codec for audio compression:

• G.711

• G.729AB

Audio Compression

Select RFC2833.RTP Digit Relay Mode

Select Off.Signaling Digit Relay Mode

Select On.Voice Activity Detection

Select the applicable setting:

• G.711—20

• G.729AB—10

Failure to use the correct setting results in
recorded messages containing nothing but
silence.

Caution

Frame Size
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SettingsField

Select the applicable setting:

• G.711—1

• G.729AB—2

Failure to use the correct setting results in
recorded messages containing nothing but
silence.

Caution

Frames Per Packet

Quality of Service

Enter 104 (equivalent to DSCP AF31).Call Control QOS Byte

Enter 184 (equivalent to DSCP EF).RTP QOS Byte

Traps and Alarms

Select No.E-mail Alarms Enabled

Select No.SNMP Traps Enabled

Select Yes.HTTP Server Enabled

Select No.HTTPs Server Enabled

Step 15 Select Apply Changes.
Step 16 On the Gateway page, select the Gateway Capabilities tab.
Step 17 Enter the following settings for all ports that are used by voice messaging ports on Unity Connection.

Table 90: Gateway Capabilities Tab Settings

SettingField

Select Both.Telephony Port Capability

For ports that are used by voice messaging ports on Unity
Connection, select Yes.

For ports that are not used, select No.

Telephony Port Enabled

Step 18 Select Apply Changes.
Step 19 On the Configure menu, select T1E1.
Step 20 On the T1E1 page, select the T1/E1 Mode tab.
Step 21 On the T1/E1 Mode tab, enter the following settings.

Table 91: T1/E1 Mode Tab Settings

SettingField

Select T1.Line Mode
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SettingField

Select CAS.Signaling Mode

Select Terminal.Interface Mode

Step 22 Select Apply Changes.
Step 23 Select the T1-CAS Protocol tab.
Step 24 On the T1-CAS Protocol tab, enter the following settings.

Table 92: T1-CAS Protocol Tab Settings

SettingField

Select Loop_Start.T1 CAS Protocol

Select B8ZS.Line Encoding

Select EFS.Framing

Select Short_Haul_110ft.Selects Transmit Pulse Waveform

Enter 550.Flash Hook

Enter !!.Consult Call Dialtone Drop Code

Enter !!.Consult Call Proceeding Drop Code

Enter !.Consult Call Busy Drop Code

Enter !!.Consult Call Error Drop Code

Enter ,,,,.Consult Call Connected Drop Code

Enter !.Consult Call Disconnected Drop Code

Select No.MWI confirmation Tone

Select TypeII_CPID.CPID Type

Enter 5000.Initial Wait for Inband CPID

Enter 500.Inband CPID Complete Timeout

Step 25 Select Apply Changes.
Step 26 On the Configure menu, select SIP.
Step 27 On the SIP page, enter the following settings.

Table 93: SIP Page Settings

SettingField

Enter the domain name of the TIMG unit.Host and Domain Name
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SettingField

Select UDP.Transport Type

Select No.Call as Domain Name

Select No.SIPS URI Scheme Enabled

Enter 120.Invite Expiration

Enter the IP address of the DNS server.DNS Server Address

Leave this field blank.Registration Server Address

Enter 5060.Registration Server Port

Enter 3600.Registration Expiration

Select Yes.UDP/TCP Transports Enabled

Enter 5060.TCP/UDP Server Port

Leave this field blank.Primary Proxy Server Address

Not applicable. Leave the default setting.Primary Proxy Server Port

Not applicable. Leave the default setting.Backup Proxy Server Address

Not applicable. Leave the default setting.Backup Proxy Server Port

Enter 10.Proxy Query Interval

Enter 500.T1 Time

Enter 4000.T2 Time

Enter 5000.T4 Time

Step 28 Select Apply Changes.
Step 29 On the Configure menu, select Tones.
Step 30 On the Tones page, select the Learn tab.

Destination addresses cannot be duplicated in the same session. Otherwise, the process for learning tones do
not succeed. If you do not have enough available phones to learn all the tones at one time, you can run multiple
sessions to learn tones individually by checking or unchecking the applicable Acquire Tone check boxes.

Caution

Step 31 On the Tones page, for the Dialtone event, confirm that the Acquire Tone check box is checked and leave the Destination
Address field blank.

Step 32 On the Tones page, for the Busy Tone event, confirm that the Acquire Tone check box is checked and do the following
substeps to verify that the tone is correct.
a) From a available phone, call a second phone.
b) Answer the second phone when it rings, and leave both handsets off so that both phones are busy.
c) From a third phone, dial one of the busy phones.
d) Confirm that you hear a busy tone.
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e) Hang up the third phone but leave the handsets for the other two phones off.

Step 33 On the Tones page, in the Destination Address field for Busy Tone, enter the extension that you dialed in Step 32c.
from the third phone.

Step 34 On the Tones page, for the Error/Reorder Tone event, confirm that the Acquire Tone check box is checked and do the
following substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does not exist.
b) Confirm that you hear the reorder or error tone.
c) Hang up the phone.

Step 35 On the Tones page, in the Destination Address field for Error/Reorder Tone, enter the extension that you dialed in
Step 34a.

Step 36 On the Tones page, for the Ringback Tone event, confirm that the Acquire Tone check box is checked and do the
following substeps to verify that the tone is correct.
a) From an available phone, dial an extension that does exist.
b) Confirm that you hear the ringback tone.
c) Hang up the phone.

Step 37 On the Tones page, in the Destination Address field for Ringback Tone, enter the extension that you dialed in Step 36a.
Step 38 Select Learn.
Step 39 When the process is complete, check the check box for each newly learned tone and select Apply.
Step 40 Hang up the phones that you used in Step 32.
Step 41 On the Configure menu, select Import/Export.
Step 42 On the Import/Export page, under Export Settings, select Export Settings.
Step 43 In the File Download dialog box, select Save.
Step 44 In the Save As dialog box, browse to theWindows workstation that has access to the TIMG units, browse to a directory

where you want to save the file, and select Save.
Step 45 In the Download Complete dialog box, select Open. Notepad opens the file Config.ini that you saved.
Step 46 Locate the line with the following parameter:

telautoanswer

Step 47 Confirm that the value of the parameter is no so that the line reads as follows:

telautoanswer = no

Step 48 Locate the line with the following parameter:

telFacCDropProc

Step 49 Confirm that the value of the parameter is !! so that the line reads as follows:

telFacCDropProc = !!

The telFacCDropProc parameter must be set to !!. If the telFacCDropProc parameter is set to 1, supervised
transfers fail, and the caller hear the called party standard greeting two times.

Caution

Step 50 Save the file, and exit Notepad.
Step 51 On the Configure menu of the TIMG unit, select Import/Export.
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Step 52 On the Import/Export page, under Import Settings, select Browse.
Step 53 In the Choose File dialog box, browse to the file Config.ini that you saved.
Step 54 Select Config.ini, and select Open.
Step 55 On the Import/Export page, select Import Settings.
Step 56 When prompted to restart the TIMG unit, select OK.
Step 57 When the TIMG unit has restarted, in the View menu, select Refresh.
Step 58 Repeat Step 1 through Step 57 on all remaining TIMG units.
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